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About This Guide 

 

The SEDAR® Filer User’s Guide explains how filing 
service subscribers can use the SEDAR system to 
process filings electronically and perform related 
tasks. 

 
Assumptions 

 
This guide is written with the following assumptions: 

 

• You are familiar with the securities regulatory 
process and the national and provincial rules 
pertaining to the filing of securities documents. 

• You have installed SEDAR, complying with the 
hardware and software requirements. 

• You have made arrangements for electronic 
payment with a Canadian financial institution 
offering financial electronic data interchange (EDI) 
services. 

• You are familiar with the Windows environment 
and have the documents to be filed electronically 
prepared in the acceptable PDF, XML and XLSX 
format, as described in the National Instrument 
and the SEDAR Filer Manual. 
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SEDAR Documentation 
 

For more information on using SEDAR, consult the 
following documentation: 

 

• SEDAR Installation Guide—Provides step-by-step 
instructions on installing SEDAR. 

• National Instrument—Contains the regulations 

governing electronic filing. 

• SEDAR Filer Manual—Contains the procedures 
and guidelines for electronic filing. 

 
Getting Help 

 
If you have problems using SEDAR, select Help for 
online information. If your specific problem is not 
addressed, call the CSA Service Desk for assistance 
at 1-800-219-5381. 
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Chapter 1 

Introduction to SEDAR 
 

Welcome to SEDAR—the System for Electronic 
Document Analysis and Retrieval. SEDAR is a 

client-server software application designed to facilitate 
and enhance the securities filing process in Canada. 

 

SEDAR provides the following services: 
 

• Cost-efficient filing of  electronic filings 

• Electronic payment of filing fees 

• Electronic communication with filing partners, the 
Canadian Securities Administrators and market 
centres 

• Access to a growing database of information on 
Canada’s issuers. 

 

Prior to SEDAR, issuers filing in more than one 
jurisdiction had to assemble multiple copies of all 
necessary securities documents with attached 
cheques for each agency. SEDAR enables all relevant 
documents and fees to be electronically assembled 
and filed to all the desired agencies while the payment 
instructions are submitted to the financial institutions 
simultaneously. 
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SEDAR provides the subscriber with a series of blank 
electronic forms containing fields for information 
required by the agencies for filings sent to them. The 
subscriber fills in the forms and then electronically 
“attaches” the underlying securities documents and 
payment instructions to the completed forms for 
submission. 
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1.1 Accessing and Exiting SEDAR 
 

The SEDAR main window is the launch point for 
accessing all modules in SEDAR. Help can be 
accessed from here as well as from all the other parts 
of the system. The SEDAR main window has a File 
menu from which you can select Database 
Maintenance, Receive Items from SEDAR Server, 
View Error Log and View Virus Logs. 

 

Only one module can be accessed from the main 
window at a time, except for Customer Assistance and 
System Information. You cannot close the SEDAR 
main window until all modules have been closed. 

 
Accessing SEDAR 

 
To connect to the SEDAR server: 

 

• If you are using a site-to-site Internet VPN 
connection, you automatically connect to SEDAR 
whenever you take an action that requires that you 
access the server (e.g., refreshing the information 
in the User Information dialog box). 

• If you are using a standard Internet connection 
(high-speed or dialup), you must open your access 
to the SEDAR server. On the Start menu, point to 
Programs, select SEDAR and click VPNConnect. 
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The following message displays: 
 

 

 
Once connected, the following message displays: 

 

 
 

To access SEDAR, for all supported Windows 
operating systems, on the Start menu, point to 
Programs, select SEDAR and click SEDAR, or 
double-click the SEDAR shortcut if you created 
one. 

 

The SEDAR main window displays. 
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Exiting SEDAR 
 

To close SEDAR, on the SEDAR main window, from 
the File menu select Exit. 

 

 

 
To disconnect from the SEDAR server: 

 

• If you have a site-to-site Internet VPN connection, 
you are automatically disconnected when you exit 
SEDAR. 

• If you have a standard Internet connection (high- 
speed or dial), you must disconnect. On the Start 
menu, point to Programs, select SEDAR and click 
VPNDisconnect. 

The following message displays: 
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Once disconnected, the following message 

displays: 
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1.2 Using SEDAR 
 

SEDAR uses two types of windows: 
 

• A standard window with both pull-down menus and 
buttons. If both options are available for the same 
operation, the button method is usually given in this 
guide. These windows are like this example: 

 

 

• A type of window that uses the notebook format 
with tabs like this example: 
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You can do the following within either window: 
 

• Move between buttons or fields by pressing TAB. 
SHIFT+TAB moves back to the previous button or 
field. 

• Move within a field using the arrow keys. 

• Move between tabs in the notebook type window 
by clicking the name of the tab at the top of the 
window. 

 

The Filing Service User Functions are specific to the 
tasks performed by filing service subscribers in 
processing electronic filings. The General Functions 
are common to all SEDAR users. These functions 
enable informal correspondence and e-mail and 
provide system- and user-related information. 

 

To read any files that were attached to either a 
comment letter or a receipt, you must download the 
files from the SEDAR server and view them using 

Adobe AcrobatTM Reader. For more information, refer 
to the SEDAR Filer Manual. 

 

The modules on the SEDAR main window are shown 
and described in the following table. 

 

Click… To... 
 

 

Create and submit filings to the SEDAR 

server, monitor the status of filings in 

progress and receive formal 

correspondence from agencies 
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Click… To... 
 

 

                Create, update and submit filer profiles 

Search for filings in the SEDAR Filings 

database on the SEDAR server 

 
 

Search for profiles of electronic filers in the 

SEDAR Filer Profiles database 

 
 

Send and receive files and electronic mail, 

and create a local address book 

 
 

             Set up your user defaults in SEDAR 

             Find out where to obtain help 

Obtain hardware and software information 
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1.3 Setting Up SEDAR 
 

The User Profile and Defaults module enables you to 
set your user profiles, defaults and preferences. 

 
Setting Your Defaults and Preferences 

 
1. On the SEDAR main menu, click User Profile and 

Defaults. 

 
The User Profile and Defaults window displays. 

 

 

 
2. Click User Defaults. The User Defaults dialog box 

displays. Set your preferences as described below. 
 

Click… To... 
 

 

Select the date format to appear 

throughout SEDAR. You must use 

this format whenever you enter 

dates 
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Click… To... 

 
Select the language (English or 

French) for SEDAR 

 

 
Enter your default user ID and 

password to add or remove the 

user ID password prompt. 

Change your password for the 

host server 

Specify the directory where PDF 

files will be stored, and the default 

directory for attaching files prior to 

submitting formal correspondence 

Select the default value for: 

• the search inquiry function 

• the previous issuers filings 

retrieval 

Select the default font to display 

the fee information found in the 

Add/Modify Fees window 

 

 
3. When done, click OK to return to the User Profile 

and Defaults window. 



Filer User's Guide 8.054 Page 18 

Introduction to SEDAR 
 

 

 
 

 

Entering Your User Information 
 

1. On the User Profile and Defaults window, click 
User Information. 

 
The User Information dialog box displays. 

 

 
 

2. Complete the Name (Last, First) field and all fields 
in the Mailing Address section. Note: The Subject 
To field indicates the tax status based on the 
Province/State selected. 

 

3. Select one of the actions shown below. 
 

Click… To… 
 

 

 Submit Send the information to the SEDAR server 
 

 

 Refresh          See the most current information on the 
server 
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Click… To… 
 

 

Cancel Return to the User Profile and Defaults 

window. If you have not submitted the 

changes, you will see a confirmation 

message before returning to the window 
 

 

Help Obtain online assistance 
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1.4 Verifying Your Access and Banking 
Authorization 

 
In the User Profile and Defaults module, verify that the 
information on your access code and banking account 
matches what you indicated on SEDAR Form 1 as 
follows: 

 

1. On the SEDAR main window, click User Profile and 
Defaults. The User Profile and Defaults window 
displays. 

 

2. Click User Information. 
 

The User Information dialog box displays. 
 

 

 
3. Click Banking Authorization. 

 

The Access and Banking Authorization dialog box 
displays. 
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4. Review the information and do one of the following: 
 

• If the information is incorrect, contact the CSA 
Service Desk for assistance at 1-800-219-
5381. 

• If the information is correct, click OK to close 
the Access and Banking Authorization dialog 
box. The User Information dialog box re- 
displays. 

 

5. Click either: 
 

• Cancel—To return to the User Profile and 
Defaults window, if you have already sent your 
user information to SEDAR. 

 
Select Exit. The SEDAR main window displays. 

• Submit—To send your user information now. 
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Chapter 2 

Maintaining Filer Profiles 

2.1 Overview 
 

In order for a filer to submit their documents to the 
recipient agencies electronically using SEDAR, the 
filer must first have a filer profile on the SEDAR server. 
If the filer has not previously submitted documents, a 
profile must be created and submitted (see “About 
Filer Profiles”). 

 

If the filer has previously submitted documents 
electronically through SEDAR, their profile must be 
retrieved from the SEDAR server and re-used for 
subsequent filings (see “Searching for Profiles”. 

 

Each document to be included in an electronic filing 
must be assembled as a separate file and saved in 
PDF, XML or XLSX as described in the SEDAR Filer 
Manual. 

Keeping the documents separate ensures that they 
can be retrieved individually. 
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About Filer Profiles 
 

There are four different types of profiles, each of which 
must be completed by a different category of filer. The 
four types of profiles are shown below. 

 

Profile type To be completed and filed by… 
 

 

Investment 

Fund Group 

Investment 

Fund Issuer 

Each investment fund group 
 

Each investment fund issuer. A profile for the 

investment fund group that the investment fund 

issuer belongs to must first be created and 

submitted 
 

 

Other Issuer A non-investment fund issuer  
 

 

Other Filer Any electronic filer not covered by the other 

types 

 
SEDAR assigns each filer profile a profile number. 
This number uniquely identifies each filer so that filings 
made by or on behalf of the filer can be tracked by the 
recipient agencies and the SEDAR server. A 
temporary number is first assigned to a profile. When 
the profile is submitted to the server, this number is 
then replaced with a permanent eight-digit number. 

 

When you create and submit a new profile, it is 
confidential. Only you, the commissions and the 
market centres to which you have submitted the 
electronic filing and the secondary filers you have 
designated for that filing can view it while it is not 
public. 
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A filer profile is private until one of the following 
situations occurs: 

 

• An agency who received the project makes public 
any documents in the project. 

• The profile is submitted with a continuous 
disclosure filing for a filer in the Investment Fund 
Issuer or Other Issuer profile types. Filings in these 
categories are automatically made public other 
than the filing types  “Other Filings”, “Personal 
Information Form and Authorization 51-105F3A”, 
“Personal Information Form and Authorization 51-
105F3B” and “For Regulator’s Use Only” as 
described in the SEDAR Filer Manual. 

• The profile is submitted with an exempt market 

offerings and disclosure filing that has an “auto-

public” access level 

• An electronic filer, or an authorized filing agent 
acting on their behalf, requests that the filer profile 
they have filed be made available to the public. For 
more information, refer to the SEDAR Filer Manual. 
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2.2 Starting a Profile 
 

You can create a filer profile by entering prescribed 
information in electronic fields using the SEDAR 
Profile Management module. The information entered 
in the fields is transmitted to the SEDAR server where 
it is processed and stored in the Filer Profile database. 

 
The profile information becomes accessible to all 
SEDAR users when any document in a filing 
containing that profile is made public or when the 
electronic filer, or a filing agent acting on their behalf, 
requests that the filer profile be made public. 
Therefore, it is very important that you make sure that 
all the information in your filer profile is current before 
submitting a filing to SEDAR. 

 

The required fields for each profile vary according to 
the profile type. All fields with italicized names are 
mandatory and must be filled in as a minimum before 
the profile can be submitted to the server. 

 

1. On the SEDAR main window, click Profile 
Management. 

 

The Profile Management window opens, displaying 
all the profiles residing on your computer. 

 

 
 

2. On the File menu, select New Profile or click 
the New Profile button. 
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The Filer Type dialog box displays, listing the four 
profile types. 

 

 
 
 

3. Select a profile type. 
 

 
Note: For Investment Fund Issuer profiles, you 

must first submit a profile for the investment 
fund group to which that investment fund 
issuer belongs before you can create a 
profile for an individual issuer. 

 

Note: If there is more than one issuer within an 
investment fund group, you need to create a 
filer profile for each issuer. You can save 
time by using the Copy Profile command on 
the File menu. 

 

4. Click OK. The [type of filer] Profile Information - 
New dialog box displays a temporary profile 
number assigned to the profile. 

 

 

 
From this point on, the information required for the 
profile types varies. 



Filer User's Guide 8.054 Page 27 

Maintaining Filer Profiles 
 

 

 
 

 

For information on creating a specific profile, see 
one of the following sections: 

 

• “Creating an Investment Fund Group Profile”  

• “Creating an Investment Fund Issuer Profile”  

• “Creating an Other Issuer Profile”  

• “Creating an Other Filer Profile”  
 

 

2.3 Creating an Investment Fund Group Profile 
 

Access the Investment Fund Group Profile 
Information-New dialog box. For more information, see 
“Starting a Profile”. 

 

1. On the Investment Fund Group Profile 
Information-New dialog box, click the Name and 
Manager tab at the top of the dialog box and fill in 
all mandatory fields. 

 

 
 

2. Click Mailing Address. 
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The Mailing Address dialog box displays. 
 

 

 
3. Fill in all mandatory fields and click OK when done 

to return to the Investment Fund Group Profile 
Information-New dialog box. 

 

4. Click Head Office Address. The Head Office 
Address dialog box displays. 

 

5. Fill in all mandatory fields and click OK 
when done to return to the Investment Fund 
Group Profile Information-New dialog box. 

 
6. Click the Principal Regulator tab and select a 

principal regulator from the drop-down list. If 
the issuer is a non-reporting issuer, select 

“Non-Reporting Issuer”. 
 

 

 
7. If “Non-Reporting Issuer” was selected, go to step 

11. 
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8. Select Yes or No to indicate if the basis for 
determining the principal regulator is the location 
of its head office. 

 

If you select Yes, no further action is required. Go to 
step 11. 

 

If you select No, go to step 9. 
 

9. Select Yes or No to indicate if the basis for 
determining the principal regulator is the result of 
an approved change. 

 

If you select Yes, no further action is required. Go to 
step 11. 

 

If you select No, go to step 10. 
 

10. Select the connection for determining the principal 
regulator from the drop-down list. 

 

11. Once you have completed all the mandatory fields, 
the Submit button becomes available. Do one of 
the following: 

 

• Click Save to store the profile on your computer 
for submission at a later time. The Profile 
Management window displays with the profile 
listed with a READY status. 
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• Click Submit to send the profile to the server. 
Once the profile has been submitted, the Profile 
Management window displays showing the 
profile with a permanent profile number 
assigned to it. The date and time of the 
submission are also indicated. 
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2.4 Creating an Investment Fund Issuer Profile 
 

For Investment Fund Issuer profiles, you must first 
submit a profile for the investment fund group to which 
that investment fund issuer belongs before you can 
create a profile for an individual issuer. If you have not 
already created an Investment Fund Group profile, 
see “Creating an Investment Fund Group Profile”. 

 

If there is more than one issuer within an investment 
fund group, you need to create a filer profile for each 
issuer. You can save time by using the Copy Profile 
command on the File menu. 

 

Note: If the issuer has selected “Ceased Reporting” 
in the Jurisdiction where Reporting Issuers 
field, you cannot use the Copy Profile 
command to create a filer profile. 

 

If you are not on the Investment Fund Issuer Profile 
Information-New dialog box, see “Starting a Profile”  

 

 
1. On the Investment Fund Issuer Profile 

Information-New dialog box, click the Name tab at 
the top of the dialog box and fill in all mandatory 
fields. 

 
 
 
 
 

 
Click Mailing Address 

and Head Office 

Address and complete 

mandatory information 

 
 
 
 
 

 

2. Click Mailing Address. The Mailing Address, dialog 
box displays. 
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3. Fill in all mandatory fields and click OK when done 
to return to the Investment Fund Issuer Profile 
Information - New dialog box. 

 

4. Click Head Office Address. The Head Office 
Address dialog box displays. 

 

5. Fill in all mandatory fields and click OK when done 
to return to the Investment Fund Issuer Profile 
Information - New dialog box. 

 

6. Click the Issuer Details tab and fill in all mandatory 
fields. 

 

 

 
7. Click the Reporting tab and select the jurisdiction 

where the issuer is a reporting issuer in the list. If 

the issuer is a non-reporting issuer, select “Non- 

Reporting Issuer” 
 

 
 
 
 

If Ceased Reporting is 
selected, a profile can no 
longer be used to submit 

filings or copied for use 
as a new profile 



Filer User's Guide 8.054 Page 33 

Maintaining Filer Profiles 
 

 

 
8. Click the External Parties tab and select an item 

in the list on the left. Enter the required 
information in the fields on the right. Repeat for 
every item, then go to step 9. 

 

 

 
9. Click the Previous Issuers tab and select the 

profiles contained in the history of the profile 
currently being added or updated. 

 

Use this tab to include 

previous information about 

an issuer and facilitate 

your searches in the 

database 

 
For example, in the case of 

a merger or amalgamation 

this tab displays (and is 

used to select) the issuers 

that were merged or 

amalgamated and made it 

necessary to create this 

profile 
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10. Once you have completed all the mandatory fields, 
the Submit button becomes available. Do one of 
the following: 

 

• Click Save to store the profile on your computer 
for submission at a later time. The Profile 
Management window displays with the profile 
listed with a READY status. 

• Click Submit to send the profile to the server. 
Once the profile has been submitted, the Profile 
Management window displays the profile with a 
permanent profile number assigned to it. The 
date and time of the submission are also 
indicated. 

 

 

2.5 Creating an Other Issuer Profile 
 

1. On the Other Issuer Profile Information - New 
dialog box, click the Name and Contact tab at the 
top of the dialog box and fill in all mandatory fields. 

 
 
 
 
 

 
Click Mailing 

Address and Head 

Office Address and 

complete mandatory 

information 

 
 
 
 
 
 

 
2. Click Mailing Address. The Mailing Address, dialog 

box displays. 
 

3. Fill in all mandatory fields. When done, click OK to 
return to the Other Issuer Profile Information - New 
dialog box. 
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4. Click Head Office Address. The Head Office 
Address dialog box displays. 

 

5. Fill in all mandatory fields. When done, click OK to 
return to the Other Issuer Profile Information - New 
dialog box. 

 

6. Click the Issuer Details tab and fill in all mandatory 
fields. 

 

 

 
7. Click the Reporting and Markets tab 

• Select the jurisdiction where the issuer is a 
reporting issuer. If the issuer is a non-reporting 
issuer, select “Non-Reporting Issuer” 

• Select the jurisdiction where the issuer is an 
OTC Reporting Issuer 

• Select each stock exchange where the issuer’s 
securities are listed. 

 

 
 

If Ceased Reporting is 
selected, a profile can 
no longer be used to 
submit filings or copied 
for use as a new profile 
 
If the issuer is listed on 
a Canadian stock 
exchange, you must 
enter the appropriate 
stock symbol 
(maximum of 5 
uppercase letters) 
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8. Click the Principal Regulator tab and select a 
principal regulator from the drop-down list. If 
the issuer is a non-reporting issuer, select 

“Non-Reporting Issuer”. 
 
 

 

 
9. If “Non-Reporting Issuer” was selected, go to step 

13. 
 

10. Select Yes or No to indicate if the basis for 
determining the principal regulator is the location of 
its head office. 

 

If you select Yes, no further action is required. Go to 
step 13. 

 

If you select No, go to step 11. 
 

11. Select Yes or No to indicate if the basis for 
determining the principal regulator is the result of 
an approved change. 

 

If you select Yes, no further action is required. Go to 
step 13. 

 

If you select No, go to step 12. 
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12. Select the connection for determining the principal 
regulator from the drop-down list. 

 

13. Click the External Parties tab and select an item in 
the list on the left. Enter the required information in 
the fields on the right. Repeat for every item then 
go to step 14. 

 
 
 
 

 

Select every item in 

this list one after the 

other and complete 

the mandatory fields 

for each one 
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14. Click the Previous Issuers tab and select the 
profiles contained in the history of the profile 
currently being added or updated. 

 

Use this tab to include 

previous information 

about an issuer and 

facilitate your searches in 

the database 

 
For example, in the case 

of a merger or 

amalgamation this tab 

displays (and is used to 

select) the issuers that 

were merged or 

amalgamated and made 

it necessary to create this 

profile 

 

 

15. Once you have completed all the mandatory 
(i.e., italicized) fields, the Submit button becomes 
available. Do one of the following: 

 

• Click Save to store the profile on your computer 
for submission at a later time. The Profile 
Management window displays with the profile 
listed with a READY status. 



Filer User's Guide 8.054 Page 39 

Maintaining Filer Profiles 
 

 

 
 

 

• Click Submit to send the profile to the server. 
The SEDAR server reviews the profile details to 
ensure that the stock symbol provided (for 
Other Issuer profile types only) is not already 
being used in another Other Issuer’s profile. If a 
message displays indicating that the stock 
symbol is already in use, the profile update is 
not submitted and the Last Updated/Status 
column in the Profile Management window 
indicates the profile’s status as ReSubmit. 
Click Update, correct the profile’s stock symbol 
and click Submit. The profile cannot be 
submitted until the stock symbol has been 
corrected. 

• If the message persists, contact the CSA 
Service Desk for additional assistance at 1-
800-219-5381. 

• Once the profile has been submitted, the Profile 
Management window displays, showing the 
profile with a permanent profile number 
assigned to it. The date and time of the 
submission are also indicated. 
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2.6 Creating an Other Filer Profile 
 

1. On the Other Filer Profile Information - New dialog 
box, click the Name and Contact tab at the top of 
the dialog box and fill in all mandatory fields. 

 
 
 
 
 

Click Head Office 

Address and complete 

the mandatory 

information 

 
 
 
 
 
 
 
 

2. Click Head Office Address. The Head Office 
Address dialog box displays. 

 

3. Fill in all mandatory fields and click OK when done 
to return to the Other Filer Profile Information - 
New dialog box. 
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4. Click the Previous Issuers tab and select the 
profiles contained in the history of the profile 
currently being added or updated. 

 

Use this tab to include 

previous information 

about an issuer and 

facilitate your searches in 

the database 

 
For example, in the case 

of a merger or 

amalgamation this tab 

displays (and is used to 

select) the issuers that 

were merged or 

amalgamated and made 

it necessary to create this 

profile 

 

 

5. Once you have completed all the mandatory fields, 
the Submit button becomes available. Do one of 
the following: 

 

• Click Save to store the profile on your computer 
for submission at a later time. The Profile 
Management window displays with the profile 
listed with a READY status. 

• Click Submit to send the profile to the server. 
Once the profile has been submitted, the Profile 
Management window displays showing the 
profile with a permanent profile number 
assigned to it. The date and time of the 
submission are also indicated. 
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2.7 Searching for Profiles 
 

The Search Profiles module enables you to retrieve 
profiles from the SEDAR server by creating and 
submitting customized inquiries. Once you create an 
inquiry, you submit it to the server. The server sends 
back a report listing all profiles that satisfy the search 
criteria. 

 

The following search tips will help you make your 
inquiries faster and more effective. 

 
Using Indexed Fields 

 

The SEDAR database contains indexed fields (fields 
for which an index exists) that allow faster retrieval of 
data. The database is much like a book. If you are 
looking for a topic, you turn to the book’s index where 
you see the page number for that topic and you go 
directly to those pages. If you do not find the topic in 
the index, you may need to flip through every page of 
the book to find the topic. Clearly, it takes longer to go 
through each page of the book than it does to use the 
index. 

 

Similarly, building inquiries using these indexed fields 
helps you locate data faster by speeding up the 
processing time in SEDAR. You build inquiries from 
the Build Issuer Profile Database Inquiry dialog box. 

 

Only the Investment Fund Group Number and the 
Profile Number indexed fields are available for profile 
searches. 
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When choosing a field that is not indexed, avoid 
including more than one criterion in the Criteria field 
(e.g., B.C., British Columbia). Adding more criteria 
reduces the volume of retrieved data but increases the 
retrieval time. 

 
Recommended Operators and Criteria 

 

The operators and criteria you select affect whether an 
index is used to find the data. Use the operators and 
tips listed in the table below to build inquiries. 

 

Operator Tips 
 

 

= •  Use the = operator instead of the >=, <=, > or < 

operators, whenever possible 

• Whenever possible, select or enter only one 

criterion for a field that is not indexed. Selecting 

more than one criterion reduces the volume of 

data retrieved but increases the time it takes to 

find the data 
 

 

Like •  Do not place a wildcard character in the first 

position of a search criteria (for example, *Issuer 

Name) when using this operator. If a character 

exists for the field you selected, the index will not 

list the entry 

• To reduce the number of projects or profiles being 

returned and make your inquiry faster, enter as 

many characters as you can before placing a 

wildcard character as the last character. Do not 

place a character after a wildcard 

• Whenever possible, select or enter only one 

criterion for a field that is not indexed. Selecting 

more than one criterion reduces the volume of 

data retrieved but increases the time it takes to 

find the data 
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Using Operators Effectively 

 

Before adding criteria to a profile search inquiry, 
always specify whether the type of profile you are 
searching for is one of the following: 

• Other Issuer 

• Investment Fund Group/Investment Fund Issuer 

• Other Filer. 
 

The table below shows the most efficient ways to 
retrieve information. 

 

To search by… Use… 
 

 

Profile number For the Profile Number field, use the = operator and enter: 

• the profile number excluding the zeros at the beginning of the 

number. A single profile is retrieved 

• more than one number separated by semicolons to search on 

multiple profiles (Note that only public profiles are retrieved) 

A filer’s full 

name 

 
 
 
 

One or more 

words that the 

filer’s name 

starts with 

 

 
The industry to 

which the 

company 

belongs 

For the Issuer/Filer Name, English field, use the = operator and 

enter the full name of the company 

Note: Be sure to enter the exact name used when the profile was 
created or last updated. If you know the profile number, 
use it instead to reduce the search time 

For the Issuer/Filer Name, English field, use the Like operator, 

type in as many of the words in the company name as possible 

and enter an asterisk (*) as the last character 

More than one profile may be retrieved, depending on the amount 

of information you entered in the Criteria field 

For the Industry Classification of Issuer field, use the = operator 

and select one of the choices. This reduces the number of profiles 

retrieved but may increase the retrieval time 
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To search by… Use… 
 

 

The company’s 

stock symbol 

For the Stock Symbol field, use any operator except Not= and Not 

Like. Enter a maximum of five uppercase letters (A–Z) 

 

 

2.7.1 Building a Search Inquiry 
 

To build a search inquiry, you specify field, operators 
and criteria. 

 

1. On the SEDAR main window, click the Search 
Profiles module. 

 

The Search Profiles main window displays. 
 

 
 

This is where the inquiries you create and submit 
are listed. The list is empty until you save or submit 
the first inquiry. 
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2. Click New Inquiry. 
 

The Build Issuer Profile Database Inquiry dialog 
box displays. 

 

 

 
3. In the Inquiry Name field, give a name to your 

inquiry of up to eight characters. Press TAB. In the 
Description field, enter additional information (up to 
40 characters) to help you identify the inquiry. Both 
of these fields must be completed in order to save 
or submit the inquiry. 

 

4. Select the profile types you would like to search on. 
The option All Profile Types is selected by default. 
Ensure that you have selected the correct profile 
types before you start adding criteria to the inquiry. 

 

5. Select a field from the List of Fields to Search On. 

For each field you select, the available operators 
appear. 

 

6. Select an operator. The operator determines the 
relationship between the field you are searching on 
and a specific criterion. 
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7. Enter a criterion. If you have selected the Like 
operator, type an asterisk at the end of your 
criterion, if you want to include all occurrences of 
the keyword followed by another word. 

 

For more information on operators and criteria, see 
“Recommended Operators and Criteria”. 

 

8. Once you have selected a field, operator and 
criteria combination you can either: 

 

• Add it to the inquiry, and view only the selection 
you added 

• Add more inquiries (field, operator and criteria 
combinations). 

 
To add another query, click Add/Keep Adding 
and the selected field will be marked with an 
asterisk. Repeat steps three to eight to add 
more queries to your inquiry. 

 

9. When you are finished building your inquiry, click 
Add and View after entering your last criterion. 
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The View Profile Database Inquiry dialog box 
displays. 

 

 

 
You can perform any of the actions shown below. 

 

Click… To… 
 

 

Change Operator Modify an operator if you are not 

satisfied with your selection 
 

 

Change Criteria Modify a criterion if you are not 

satisfied with your selection 
 

 

Delete Selection Delete unwanted lines if you are not 

satisfied with your selection 

Clear Inquiry Delete the entire inquiry 

Build Continue building your inquiry 
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10. Do either of the following: 
 

• Click Save to save your inquiry in your 
database before submitting it to SEDAR. The 
Search Profiles window displays. 

• Click Submit. Your inquiry is saved and displays 
in the list of inquiries. 

 
 

For more information on submitting inquiries from 
the Search Profiles window, see “Submitting a 
Search Inquiry”. 

 

2.7.2 Submitting a Search Inquiry 
 

Before you submit an inquiry to SEDAR, first save it in 
your database and then submit it to SEDAR. Once the 
report has been submitted, you can view the report 
produced by SEDAR, using the Filer Profile Report 
Viewer. 

 

Save the profiles contained in the inquiry in the 
Profiles database on your computer, using the 
following procedure: 
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1. On the View Profile Database Inquiry dialog box, 
click Save to store the inquiry on your computer. 

 

 

 
2. The inquiry displays on the Search Profiles 

window, in the List of Issuer Profile Inquiries, with 
the status “Not Submitted.” 
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3. Click Submit Inquiry to send the inquiry to the 
SEDAR server. Once the submission has been 
made, a report is sent to your computer. 

 
The Search Profiles window re-displays. 

 

4. Click Open Report. 
 

The Filer Profile Report Viewer window displays. 
 

 

 
5. Under Report Name, highlight the inquiry that you 

submitted. 

 
The List of Profiles in Selected Report displays the 
profiles that meet your criteria. The date shown 
under Last Update indicates the date when a 
profile was last modified by the filing service 
subscriber. 



Filer User's Guide 8.054 Page 52 

Maintaining Filer Profiles 
 

 

 
 

 

6. Select the profile you would like to view and click 
Open Profile. 

 
The (type of) Profile Information - Open window 
displays the profile information for the selected 
filer. 

 

 

 
7. To transfer the selected profile to your local Profiles 

database, click Transfer. 

 
Once the profile has been added to your local 
database, SEDAR prompts you with a message 
confirming that the transfer was successful. If the 
profile being transferred already exists on your 
local profile database, it is replaced by the server 
version of that profile. 

 

 
Other profiles are returned if they are related to 
profiles that match the inquiry criteria through a 
“previous profile” relationship. If you do not want to 
receive previous filer profile information, do not 
select either the Issuer/Filer Name or Profile 
Number fields in your search inquiry. 
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2.7.3 Modifying and Updating a Search 

Inquiry 

The View Filer Profile Database Inquiry dialog box 
enables you to view or modify inquiries. The field, 
operator and criteria combination for the inquiry is 
displayed. 

 

To delete a selection, or change an operator or a 
criterion, select it and select the corresponding button 
below the list field. You can also view or modify on the 
Build Filer Profile Database Inquiry dialog box. You 
can switch between the build and view modes by 
clicking OK to go to the View dialog box or clicking 
Build to go back to the Build dialog box when building 
or modifying an inquiry. You can also submit an inquiry 
to the server from the View dialog box. 

 

To change an inquiry that has already been saved or 
submitted, open and modify the inquiry as described 
above. When you submit an updated inquiry that was 
previously submitted, SEDAR prompts you to enter a 
new report name for the inquiry. 

 

If you delete an inquiry that has been submitted, all 
associated reports are also deleted, including all the 
profiles. Profiles added to your local Profile 
Management database are not deleted. 
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2.8 Monitoring Profiles 
 

From the Profile Management window, you can 
refresh profiles (to make sure that you have the latest 
information in your local database), and view the 
status of profiles. 

 
Refreshing a Profile 

 
As any filing service subscriber can update any public 
profile, it is important to ensure that your local 
database contains the current version of the profile 
before proceeding with a filing. To refresh a profile, 
click on the profile on the Profile Management window, 
then click Refresh Profile. To refresh more than one 
profile at a time, highlight the first profile to be 
refreshed, hold down the Shift key and highlight the 
last profile to be refreshed. After you click Refresh 
Profile, all of the profiles between and including the 
first and last profiles highlighted will be refreshed. 
Similarly, several profiles may be refreshed although 
they are not in sequential order in your Profile 
Management window. Highlight the first profile, hold 
down the Control key then highlight the remaining 
profiles to be refreshed by clicking on each profile. All 
the profiles highlighted will be refreshed. 

 

The Last Updated/Status column in the Profile 
Management window will indicate the date the profile 
was last updated. To review the profile details, click 
Open. If, after reviewing the refreshed profile, you 
determine that some of the profile details have not 
been updated, click OK to return to the Profile 
Management window and click Update. 
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Updating a Profile 
 

You can update a profile listed on the Profile 
Management window by highlighting the profile and 
clicking Update. Once you have updated the 
necessary fields, click Submit to update the SEDAR 
server version of this profile and your local copy. 

 
 

The Submit button will not be highlighted 
(i.e., italicized) if you have not completed all the 
mandatory fields (indicated by the field names shown 
in italics). 

 

The SEDAR server will undertake a review of profile 
details at the time of submission to ensure the stock 
symbol provided (in Other Issuer profile types only) is 
not currently indicated in another Other Issuer’s 
profile. If a message displays indicating that the stock 
symbol is already in use, the profile update can be 
submitted by clicking Yes in the warning message box. 

 

As well, if you attempt a profile update to the SEDAR 
server for any profile type, without first having 
refreshed that profile, you may receive a message 
informing you that your current local copy of the profile 
does not match the official copy on the SEDAR server. 
The Last Updated/Status column will indicate that 
profile’s status as Resubmit. You must refresh the 
profile and review its details (see “Refreshing a 
Profile”) prior to making any further changes. 



Filer User's Guide 8.054 Page 56 

Maintaining Filer Profiles 
 

 

 
 

 

A profile is updated only once submitted to the server. 
Changes that are made and saved but not submitted 
will not be reflected in the profile information included 
in an electronic filing. 

 

When updating an Investment Fund Issuer or Other 
Issuer profile to indicate that the issuer has ceased 
reporting (select the Ceased Reporting option in the 
Jurisdictions where Reporting Issuer field), be aware 
of the following: 

 

• The profile will display with the status “inactive” 
in lists of profiles for creating filings 

• The profile cannot be used to send filings to 
SEDAR 

• The profile cannot be copied and used as the 
basis for a new profile. 
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Viewing Profile Statuses 
 

The status of profiles is shown in the Last Updated 
Status column on the Profile Management window. 
The statuses and their definitions are shown below. 

 
Status Definition 

 
 

In Process A new profile has been created and stored on 

your local database. However, not all of the 

mandatory fields have been filled in, so the 

profile is not ready to be submitted to the 

server 
 

 

Ready All mandatory fields have been filled in and the 

profile is ready for submission to the server 
 

 

Resubmit An error occurred during the submission to the 

server. Correct and select Submit again to 

resubmit the profile to the server 
 

 

Date/Time Once a profile has been submitted to the 

server, the date and time when the profile was 

stored on the SEDAR server is displayed in the 

Last Updated field 
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Chapter 3 

Creating a Project 
 

3.1 Overview 

 
How a Filing Is Processed 

 
Before filing electronically, you create issuer profiles 
which contain essential information, such as the name 
and address of the issuer and the type of filer (for 
more information, see “Overview”). For each filing, 
you create cover pages which also include essential 
name and address information (for more information, 
see “About Cover Pages”). 

 

After you complete your cover page, you can 
assemble your filing by selecting recipient agencies, 
adding fees and attaching files (for more information, 
see “Completing the Project”). When you submit a 
document to SEDAR, the submission is assigned a 
permanent project number and a submission 
number. 
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Projects and Submissions 
 

A project identifies a set of electronic filings that are all 
related to a particular matter. For example, all filings 
submitted for a prospectus are identified as part of one 
project. All documents submitted by the recipient 
agencies in response to that prospectus will also be 
identified as part of the same project. In this example, 
the electronic filings making up the project would 
include the preliminary prospectus, the final 
prospectus and all formal correspondence between 
the filer and the recipient agencies during the waiting 
period. A project enables both the filers and the 
recipient agencies to track a series of electronic filings 
and related regulatory responses. 

 

To create a project, you must first ensure that your filer 
profile is in your local Profile database and it contains 
the most current information. When a new filing is 
created, the system generates a temporary project 
number that will be the same for all filings within that 
project. All filings within the same project are assigned 
a submission number, starting with 00000001 for each 
project. Until submitted, project numbers begin with 
TMP (temporary) and submission numbers with SUB 
(submission). Upon submission, the SEDAR server 
assigns the filing a permanent project and submission 
number. 



Filer User's Guide 8.054 Page 60 

Creating a Project 
 

 

 
 

 

3.2 About Cover Pages 
 

To submit filings electronically using SEDAR, you 
must complete an electronic cover page. This SEDAR 
form is used to indicate the type of issuer, type of filing 
and the documents that are to be included in the filing. 
You enter the required information directly on the form, 
then electronically attach your filer profile, files and 
fees as applicable. The cover page contains all the 
information relating to a project. Once submitted, the 
cover page cannot be deleted from the server but 
certain fields can be amended by filers. 

 

You can create your cover page if the filer profile for 
which you are filing is in your local Profile database. 

 

SEDAR offers five types of cover pages. The cover 
page you complete depends on the category of filer 
and filing and the type of filing selected, as shown in 
the table below. 

 
 

If the category 

of filer is... 

And the 

category of 

filing is... 

 
 

Use the... 

 
 

Investment Fund 

Issuers 

Securities 

Offering 

Investment Funds 

Cover Page (see 

“Creating an 

Investment Funds 

Cover Page”) 
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If the category 

of filer is... 

And the 

category of 

 
 

Use the... 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

You can save or modify a new filing before you submit 
it to the SEDAR server. Once a project’s cover page is 
created and saved, you can add recipient agencies 
and fees and attach files later when you wish. 

 

You can send a submission when all the mandatory 
(i.e. italicized) fields are filled on the cover page. All 
filings submitted by your organization are listed on the 
Filing Management window. 

 filing is...  

Investment Fund All types except General Investment 

Issuers Securities  Funds Cover Page 

 Offerings (see “Creating  a 

  General Investment 

  
 
 

 

Funds Cover Page”) 
 
 

   

Other Issuers Securities Issuer Cover Page 

 Offerings (see “Creating an 

  Issuer Cover Page”) 

   

Other Issuers All types except General Cover Page 

 Securities (see “Creating a 

 Offerings General Cover Page”) 

   

Third Party All types Third Party Cover 

Filers  Page (see “Creating 

  a Third Party Cover 

  Page”) 
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3.3 Creating an Investment Funds Cover Page 
 

To create an Investment Funds cover page for a new 
filing: 

 

1. On the SEDAR main window, open the Filing 
Management module. 

 
The Filing Management window displays. 

 

 
 

2. On the File menu select Create a New Filing. 

 
The following message displays: 
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Do not disregard this message, because, for 
example, if an issuer has ceased reporting, their 
profile will have been updated and you will no 
longer be able to use the old profile to send a filing. 
For more information on refreshing the list of 
profiles, see “Monitoring Profiles”. 

 

3. Click OK if the profiles you intend to use are up to 
date. 

 

The New Filing dialog box displays. 
 

 

 
4. Select the following: 

 

• Category of Filer—Investment Fund Issuers 

• Category of Filing—Securities Offerings. 
 

A list of possible filing types for your selection 
displays. 
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5. Select a filing type and click OK. 

 
The Investment Funds Cover Page dialog box 
displays showing information specific to the filing 
type you selected. 

 

 

 
6. Click List to display a list of investment fund group 

profiles that are stored on your profiles database. 
 

The Available Investment Fund Groups dialog box 
displays. 
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7. Select a profile and click OK. The Investment 
Funds Cover Page dialog box re-displays with the 
profile name in the Investment Fund Group Name 
field. 

 

8. Click Add Fund beside the List of Investment Fund 
Issuers field to display a list of all investment fund 
issuers in the selected fund group whose profiles 
reside on your local Profile database. 
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9. Select one or more funds and click OK. 

 
The fund names appear in the List of Investment 
Fund Issuers field. 

 

 
 

10. Click on a fund name. The Remove Fund button 
becomes available; click it if you need to delete a 
fund issuer from the list. 

 

11. Fill in the Name and Telephone fields in the 
Contact Information section. 
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12. Click Page 2. 
 

The second page of the cover page displays. 
Complete the fields as applicable. 

 

 

 
13. Click Page 1 to return to the first page. 

 

After you have completed the cover page, you can 
select recipient agencies and attach fee payment 
instructions and project files. Do one of the 
following: 

 

• To continue, do not exit the Investment Funds 
Cover Page dialog box. For more information, 
see “Completing the Project”. 

• To save your cover page on your PC workspace 
for later assembly, click Save. The project is 
assigned a temporary project number. Make 
note of the number for future reference. 
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3.4 Creating a General Investment Funds Cover Page 
 

To create a General Investment Funds cover page for 
a new filing: 

 

1. On the SEDAR main window, open the Filing 
Management module. 

 
The Filing Management window displays. 

 

 

 
2. From the File menu, select Create a New Filing. 

 
The following message displays: 
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Do not disregard this message, because, for 
example, if an issuer has ceased reporting, their 
profile will have been updated and you will no 
longer be able to use the old profile to send a filing. 
For more information on refreshing the list of 
profiles, see “Monitoring Profiles”. 

 

3. Click OK if the profiles you intend to use are up to 
date. 

 

The New Filing dialog box displays. 
 

 

 
4. Select the following: 

 

• Category of Filer—Investment Fund Issuers 

• Category of Filing—Either Continuous 
Disclosure or Exemptions and Other 
Applications. 

 

A list of possible filing types for your selection 
displays. 
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5. Select a filing type and click OK. 

 
The General Investment Funds Cover Page dialog 
box displays, showing information specific to the 
filing type you selected. 
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6. Click List to display a list of profiles stored on your 
local Profile database. 

 
The Available Investment Fund Groups dialog box 
displays. 

 

 

 

 
7. Select a profile and click OK. 

 
The General Investment Funds Cover Page Dialog 
box re-displays with the profile name in the 
Investment Fund Group Name field. 

 

8. Click Add Fund beside the List of Investment Fund 
Issuers field to display a list of all investment fund 
issuers in the selected fund group whose profiles 
reside on your local profile database. 
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9. Select one or more funds and click OK. 

Note: A separate project should be created for each 
report of exempt distribution report that is required to 
be filed. If filing for more than one investment fund, 
create a separate project for each investment fund that 
is required to file a report of exempt distribution. 

 
The fund names appear in the List of Investment 
Fund Issuers field. 

 

 

 
10. Click on a fund name. The Remove Fund button 

becomes available; click it if you need to delete a 
fund issuer from the list. 
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11. Fill in the Name and Telephone fields in the 
Contact Information section. 

 

12. Click Page 2. 
 

The second page of the cover page displays. 
Complete the fields as applicable for the filing type 
selected. These fields can be changed after 
submission. 

 

 

 
13. Click Page 1 to return to the first page. After you 

have completed the cover page, you can select 
recipient agencies and attach fee payment 
instructions and project files. Do one of the 
following: 

• To continue, do not exit the General Investment 
Funds Cover Page dialog box. For more 
information, see “Completing the Project”. 

• To save your cover page on your PC workspace 
for later assembly, click Save. The project is 
assigned a temporary project number. Make 
note of the number for future reference. 
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3.5 Creating an Issuer Cover Page 
 

To create an Issuer cover page for a new filing: 
 

1. On the SEDAR main window, open the Filing 
Management module. 

 
The Filing Management Window displays. 

 

 

 
2. On the File menu select Create a New Filing. 

 
The following message displays: 
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Do not disregard this message, because, for 
example, if an issuer has ceased reporting, their 
profile will have been updated and you will no 
longer be able to use the old profile to send a filing. 
For more information on refreshing the list of 
profiles, see “Monitoring Profiles”. 

 

3. Click OK if the profiles you intend to use are up to 
date. 

 

The New Filing dialog box displays. 
 

 

4. Select the following: 
 

• Category of Filer—Other Issuers 

• Category of Filing—Securities Offerings. 
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A list of possible filing types for your selection 
displays. The filing type selected here determines 
which recipient agencies can be selected later on 
the Add a Recipient Agency dialog box. Be careful 
to select the appropriate filing type within the 
correct folder. For example, if you select a filing 
type within the British Columbia folder, you will only 
be able to select British Columbia recipient 
agencies. 

 

5. Select a filing type and click OK. 

 
The Issuer Cover Page dialog box displays, 
showing information specific to the filing type you 
selected. 

 

 

 
6. Click List to display a list of profiles stored on your 

profiles database. 
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The Other Issuers and Other Filers dialog box 
displays. 

 
 
 
 
 
 
 

This issuer has ceased 

reporting. Select another 

profile. 

 
 
 
 

 

Note: You cannot select the profile of an issuer that 
has ceased reporting. For more information 
on refreshing the list of profiles, see 
“Monitoring Profiles”. 

 

7. Select a profile and click OK. The Issuer Cover 
Page dialog box re-displays with the profile name 
in the Issuer Name field. 

 

8. Fill in the Name and Telephone fields in the 
Contact Information section. 
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9. Click Page 2. The second page of the cover page 
displays. Complete the fields as applicable. 

 

 
10. Click Page 1 to return to the first page. 

 

After you have completed the cover page, you can 
select recipient agencies and attach fee payment 
instructions and project files. Do one of the 
following: 

 

• To continue, do not exit the Issuer Cover Page 
dialog box. For more information, see 
“Completing the Project”. 

• To save your cover page on your PC workspace 
for later assembly, click Save. The project is 
assigned a temporary project number. Make 
note of the number for future reference. 
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3.6 Creating a General Cover Page 
 

To create a General cover page for a new filing: 
 

1. On the SEDAR main window, open the Filing 
Management module. 

 
The Filing Management Window displays. 

 

 

 
2. On the File menu, select Create a New Filing. 

The following message displays: 
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Do not disregard this message, because, for 
example, if an issuer has ceased reporting, their 
profile will have been updated and you will no 
longer be able to use the old profile to send a filing. 
For more information on refreshing the list of 
profiles, see “Monitoring Profiles”. 

 

3. Click OK if the profiles you intend to use are up to 
date. 

 

The New Filing dialog box displays. 
 

 

 
4. Select the following: 

 

• Category of Filer—Other Issuers 

• Category of Filing—Any category except 
Securities Offerings. 
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A list of possible filing types for your selection 
displays. The filing type selected here determines 
which recipient agencies can be selected later on 
the Add a Recipient Agency dialog box. Be careful 
to select the appropriate filing type within the 
pertinent folder. For example, if you select a filing 
type within the British Columbia folder, you will only 
be able to select British Columbia recipient 
agencies. 

 

5. Select a filing type and click OK. 
 

The General Cover Page dialog box displays, 
showing information specific to the filing type you 
selected. 
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6. Click List to display a list of profiles that are stored 
on your local Profile database. 

 
The Other Issuers and Other Filers dialog box 
displays. 

 

 

 
7. Select a profile and click OK. The General Cover 

Page dialog box re-displays with the profile name 
in the Issuer Name field. 

 

8. Fill in the Name and Telephone fields in the 
Contact Information section. 
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9. Click Page 2. 

 
The second page of the cover page displays. 
Complete the fields as applicable for the filing type 
selected. These fields can be changed after 
submission. 

 

 

 
10. Click Page 1 to return to the first page. 

 

After you have completed the cover page, you can 
select recipient agencies and attach fee payment 
instructions and project files. Do one of the 
following: 

 

• To continue, do not exit the General Cover 
Page dialog box. For more information, see 
“Completing the Project”. 

• To save your cover page on your PC workspace 
for later assembly, click Save. The project is 
assigned a temporary project number. Make 
note of the number for future reference. 
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3.7 Creating a Third Party Cover Page 
 

To create a Third Party cover page for a new filing: 
 

1. On the SEDAR main window, open the Filing 
Management module. 

 
The Filing Management Window displays. 

 

 

 
2. On the File menu, select Create a New Filing. 

The following message displays: 
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Do not disregard this message, because, for 
example, if an issuer has ceased reporting, their 
profile will have been updated and you will no 
longer be able to use the old profile to send a filing. 
For more information on refreshing the list of 
profiles, see “Monitoring Profiles”. 

 

3. Click OK if the profiles you intend to use are up to 
date. 

 

The New Filing dialog box displays. 
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4. Select the following: 
 

• Category of Filer—Third Party Filers 

• Category of Filing—Any type. 
 

A list of possible filing types for your selection 
displays. 

 

5. Select a filing type and click OK. 

 
The Third Party Cover Page dialog box displays, 
showing information specific to the filing type you 
selected. 
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6. Click List beside the Issuer Name (Offeree) field to 
display a list of profiles that are stored on your local 
Profile database. 

 
The Investment Fund Issuers, Other Issuers and 
Other Filers dialog box displays. 

 

 

 
7. Select a profile and click OK. The Third Party 

Cover Page dialog box re-displays with the profile 
name in the Issuer Name (Offeree) field. 

 

8. Click List beside the Filer Name (Offeror) field to 
display a list of profiles that are stored on your local 
Profile database. 

 
The Investment Fund Issuers, Other Issuers and 
Other Filers dialog box re-displays. 
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9. Select a profile and click OK. 

 
The Third Party Cover Page dialog box re-displays 
with the profile name in the Filer Name (Offeror) 
field. 

 

 

 
10. Fill in the Name and Telephone fields in the 

Contact Information section. 
 

11. After you have completed the cover page, you can 
select recipient agencies and attach fee payment 
instructions and project files. Do one of the 
following: 

 

• To continue, do not exit the Third Party Cover 
Page dialog box. For more information, see 
“Completing the Project”. 

• To save your cover page on your PC workspace 
for later assembly, click Save. The project is 
assigned a temporary project number. Make 
note of the number for future reference. 
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Chapter 4 

Completing the Project 
 

4.1 Overview 
 

You use the SEDAR Filing Management module to 
assemble and submit your filings, monitor the status of 
your filings, add documents to your filings and 
exchange formal correspondence with the agencies 
reviewing your filings. 

 

You can start assembling your filing submission once: 
 

• The filer profile for which you are filing is in your 
local Profile Management database 

• You have created a cover page. 
 

After you create a cover page, you assemble your 
filing by: 

 

• Selecting recipient agencies 

• Adding fees 

• Attaching files. 
 

You can save or modify the filing at any time before 
you submit it to the server. Therefore, you may want to 
add recipient agencies and fees ahead of time and 
attach files later when they are ready. You can send a 
submission when all the mandatory fields are filled in 
on the cover page. All filings sent by your filing service 
subscriber company are listed on the Filing 
Management window. 
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4.2 Selecting Recipient Agencies 
 

Before selecting the agencies to which you will submit 
the project, you must first create the cover page. For 
more information, see “Creating a Project”. 

 

After all Issuer Information fields have been completed 
on the cover page, the Agencies button becomes 
available. 

 

Note that after the initial submission, you can only add 
recipient agencies of the type selected initially and 
only using the Add to a Filing, Document function. 

 

To select the agencies that receive a copy of the filing: 
 

1. If you are already on the project cover page, go to 
step 2. 

 

If you are not on the project cover page, open the 
Filing Management window and select the filing for 
which you want to select recipient agencies, and 
click Open. 

 
The [type of filing] Cover Page dialog box displays. 

 

2. Click Agencies. 
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The Add a Recipient Agency dialog box displays 
listing the available agencies. 

 

 

 
Depending on the category of filer, the category of 
filing and the filing type, and the folder in which it is 
located, one of the following options displays in the 
Agency Type field: 

 

• Commissions 

• Market Centres (Exchanges) 

• Commissions and Market Centres 
(Exchanges). 

 

The Test Filing option is always available. 
 

Note: To become familiar with SEDAR, you can 
submit a file as a test by clicking Test Filing. 
Your submission is sent to the SEDAR 
server but no agency receives it. 
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3. In the Agency Type field, click the agency type for 
your filing or test filing. 

 

4. In the Agency field, select the required agencies. 
 

5. Click OK. 
 

The Recipient Agencies dialog box displays with 
the agencies selected in step 4. 

 

 
 

6. Click the Principal column beside the name of a 
commission to designate it as the principal 
regulator. For non- reporting issuers, the 
principal column will display as N/A (Not 
Applicable). 

 

You cannot designate a market centre as the 
principal regulator. 

 

7. If you want to include the SEDAR e-mail ID of the 
contact person at the agency who can be 
contacted by the filer via SEDAR email when the 
filing is received by an agency, do the following: 

 

a. Click Email ID to open the Email ID dialog box. 
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b. Select the recipient agency and enter the user ID. 
 

c. Click OK. The Recipient Agencies dialog box re- 
displays showing the selected email ID in the 
Reference Email ID box. 

 

8. Click OK. The [type of filing] Cover Page dialog box 
re-displays. 

 

9. You may add fees and attach files to the project. 
Select one of the actions below. 

 
To… Do this… 

 
 

Add fees Do not close the window. See 

“Adding Fees”  
 

 

Attach files Do not close the window. See 

“Attaching a New Document”, or 

“Attaching a Previously Filed 

Document”  

Save the cover 

page information 

on your database 

for later 

submission 

Click Save. The Filing Management 

window displays 
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4.3 Adding Fees 
 

After all Issuer Information fields have been completed 
on the cover page, the Fees button becomes 
available. It can be used if you have already selected 
recipient agencies. If you have not done so, see 
“Selecting Recipient Agencies”. 

 

To indicate the amount of fees owed to the recipient 
agencies (if applicable for your filing): 

 

1. If you are already on the project cover page, go to 
step 2. 

 
If you are not on the project cover page, open the 
Filing Management window, select the filing to 
which you want to add fees, and click Open. The 
[type of filing] Cover Page dialog box displays. 

 

2. Click Fees. The Add/Modify Fees dialog box 
displays, showing the fee schedule for the first 
recipient agency on the list. 
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3. Select the agency to which you want to submit 
fees. 

 

The fee schedule for the selected agency displays 
in the Filing Fees field. 

 
 

 

 
4. Enter the fee amounts in the Amount$ column 

beside the corresponding fee descriptions. 
 

Note: Taxes are charged on all applicable market 
centre filing fees. They are calculated in the 
columns beside the Amount$ column. Taxes 
are calculated automatically based on the 
Subject To line of the User Information 
dialog box. For more information see 
“Entering Your User Information”. 
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If you are creating the cover page for an investment 
fund group, there may be more than one fund 
issuer in the group. If this is the case, the name of 
every issuer is shown in the Issuer/Filer field. You 
must select each issuer, in turn, to enter fees for the 
filings done by each one. 

 

5. To submit fees to other agencies, select another 
agency from the Agencies field. The Filing Fees list 
displays for that agency. Enter the fee amounts in 
the Amount$ column beside the corresponding fee 
description. 

 

Repeat this process for each agency to which you 
want to submit fees. 

 

6. When you have entered all the required fees, click 
OK. The Summary of Filing Fees dialog box 
displays, showing the details of fees submitted as 
follows: 

 

• Total Project Fees (to date) 

• SEDAR System Fees (to date) 

• Agency Fees (to date). 
 

The Agency Fees (to date) are for the agency 
selected in the field at the top left of the Agency 
section, and for the issuer or filer selected in the 
Issuer/Filer Name field in the case of Investment 
Funds which have multiple issuers. 
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If the agency is a market centre, all amounts in this 
section include the applicable taxes. The 
breakdown of the taxes displays at the bottom of 
the section. 

 

7. To add or delete fees, click Add/Modify. The Add/ 
Modify dialog box re-displays. 

 

• To add fees, repeat steps 3 to 6. 

• To delete fees, repeat steps 3 to 6, but delete 
the fees in the Amount$ column instead of 
entering them. 

 

Note: You cannot delete fees that have already 
been submitted to the server. 

 

8. Click OK to save the payment instructions. The 
[type of filing] Cover Page displays. 

WIP (work in progress)- 

Fees entered but not 

submitted to SEDAR 

Submitted – Total project 

fees submitted to SEDAR 

 

Paid – Submitted to SEDAR 

and confirmed as paid by a 

financial institution 

 

Rejected – Submitted to 

SEDAR but rejected by a 

financial institution (for 

example, for insufficient 

funds). All fees include 

applicable taxes. 
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9. Select one of the actions from the following table. 

 
To… Do this… 

 
 

Attach files Do not close the window. See 

“Attaching a New Document” or 

“Attaching a Previously Filed 

Document”  
 

 

Submit the project Do not close the window. See 

“Submitting the Project”  

Save the cover 

page information 

on your database 

for later 

submission 

Click Save. The Filing Management 

window displays 
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4.4 Attaching a File 
 

Before attaching a file, you must first create a cover 
page. If you have not done so, see “Creating a 
Project”. 

 

Once your cover page is created, you are ready to 
attach files. Note that the document you attach can be 
located in: 

 

• Your PC workspace 

• Your SEDAR workspace 

• The SEDAR server database. 
 

The procedure for attaching a document to your filing 
varies depending on its location. See the table below 
to find out which procedure you should follow. 

 
If your document is on... See... 

 
 

Your PC workspace “Attaching a New Document”  
 

 

Your SEDAR workspace “Attaching a New Document” 
 

 

The SEDAR server database “Attaching a Previously Filed 

Document”  
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4.4.1 Attaching a New Document 
 

To attach a previously filed document, see “Attaching 
a Previously Filed Document”. 

 

All documents that have not been previously filed must 
be saved in the format called PDF, XML or XLSX as 
applicable. For more information on this format, refer 
to section 7 of the SEDAR Filer Manual. 

 

To attach a document that has never been filed and is 
located on your PC or SEDAR workspace: 

 

1. If you are already on the project cover page, go to 
step 2. 

 
If you are not on the project cover page, open the 
Filing Management window and select the filing to 
which you want to attach a file. From the File 
menu, select Add to a Filing, Documents. The [type 
of filing] Cover Page dialog box displays. 

 

2. On the [type of filing] Cover Page dialog box, select 
a document type in the Filing Subtype/Document 
Type field and click Attach File. 
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The Attach File dialog box displays. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
To ensure that 

the files in your SEDAR     

workspace are up to date 

before attaching them, click 

Refresh List 

 
 

 
3. Select the following: 

 

• The location of the file you want to attach (PC 
workspace or SEDAR workspace) 

• The file type 

• The drive 

• The directory 

• The name of the file, with the accepted 
extension. 

 

The Document Name, Path and File fields at the 
top of the dialog box are completed automatically. 
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4. Click OK to return to the [type of filing] Cover Page 
dialog box. 

 

Note: If you attempt to send a file which contains 
annotations, such as attached files or 
embedded objects, the following message 
displays: 

 
“The file cannot contain annotations (attached 
files or embedded objects). Please remove 
them and resave the file.” 

 
For more information, see “File Messages”  

 

You can take any of the actions shown below or go 
directly to step 5. 

 

To... Do this... 
 

 

Attach many files 

to the same 

document type 

Select the document type in the Filing 

Subtype/Document Type list and click 

Duplicate to create a copy of that 

document type in the list. Repeat 

steps 3 and 4 

Attach files to a 

different 

document type 

Detach a file from 

the cover page 

Repeat steps 2 to 4 
 
 
 

From the [type of filing] Cover Page 

dialog box, select a document in the 

Filing Subtype/Document Type list and 

click Detach File 
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To... Do this... 
 

 

Add a document 

type that does not 

appear on the list 

Scroll down the Filing Subtype/ 

Document Type list, select the 

document type Other and click Add 

Document. The Add Document dialog 

box displays. Complete all fields. Click 

either: 

• OK—To return to the [type of filing] 

Cover Page dialog box 

• Add Document—To add a document 

immediately and enter another 

document type 
 

5. From the [type of filing] Cover Page, select one of 
the actions below when you have attached all the 
files you need to include in your submission. 

 
To… Do this… 

 
 

Select recipient 

agencies 

Do not close the window. See 

“Selecting Recipient Agencies”  
 

 

Submit the project Do not close the window and see 

“Submitting the Project”  

Save the cover 

page information 

on your database 

for later 

submission 

Click Save. The Filing Management 

window displays 
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4.4.2 Attaching a Previously Filed 

Document 

It is possible to reuse certain documents already 
submitted to SEDAR. For example, in the case of a 
take-over bid filing, as the filer, you may want to use 
the issuer’s financial statements to submit to agencies. 

 

The filings you are allowed to search in for documents 
are restricted to the filings associated with the profile 
number of the issuer for the filing you are creating. 
You can search on this issuer’s: 

 

• Public filings 

• Private filings for which you are the primary filer or 
a secondary filer with the Retrieve or Submit 
privilege. 

 

You cannot reuse documents sent as formal 
correspondence or with one of the following private 
access levels: 

 

• Private – Draft 

• Private – Virus 

• Private – Incorrect Filing 

• Private – Incorrect Format 

• Private – Nonpublic 

• Private – Nonpublic – Incorrect. 
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Before the implementation of Release 6.0, accepted 

file formats were: 

• For WordPerfect documents – .w51, .w52, .w60 
and .w61 

• For Word for Windows – .doc 

• For PDF documents – .pdf. 
 

You can attach a pre-release 6.0 document saved in 
any of these formats because the document on the 
SEDAR server is not actually resubmitted to the 
server. 

 

To attach a previously filed document: 
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1. If you are already on the project cover page, go to 
step 2. 

 
If you are not on the project cover page, open the 
Filing Management window and select the filing to 
which you want to attach a file. From the File 
menu, select Add to a Filing, Documents. 

 
The [type of filing] Cover Page dialog box displays. 

 

 

 
2. On the [type of filing] Cover Page dialog box, select 

the document type in the Filing Subtype/Document 
Type field and click Attach File. The Attach File 
dialog box displays. 
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3. Click Previously Filed Documents. You are 
prompted to select an issuer profile if you did not 
do so on the cover page. 

 
The Previously Filed Projects/Documents section 
displays. 

 

 

 
4. Click Search. 

 

The Search for Previously Filed Documents dialog 
box displays. 

 
SEDAR displays only the 

documents associated with 

that profile number. In the 

case of an Investment 

Fund Issuer filing, the 

profile number used is that 

of the Investment Fund 

Group 

 
The date range fields are 

unavailable when you enter 

a project number 
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5. To narrow your search, you can: 
 

• Enter a project number 

• Select a Category of Filing or a Filing Type, or 
both. You can also change the Date range if 
desired (the default is one year). 

 

6. Click Submit. After the search is done: 
 

• If there are no projects matching your search 
criteria, the Search for Previously Filed 
Documents dialog box re-displays. Change 
your search criteria or click cancel to return to 
the Attach File dialog box. 

• If there are filings matching your search criteria, 
the Attach File dialog box displays showing the 
search results. 

 

The list of projects and documents displayed 
remains available until you save, submit or cancel 
the submission from the cover page. 
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7. Select the document to attach and click OK. 
 

The [type of filing] Cover Page dialog box re-opens. 
 
 
 

The Path and File are 

automatically updated 

 
 

 
Expand the folder to display 

each document 

 
 
 
 
 
 
 
 
 

The access level of the newly attached document is 

private, regardless of its access level in the original 
project, until an agency changes the access level in 
the current project (except for filings which are 
automatically made public upon submission to 
SEDAR.) If an agency changes the access to this 
document in your current project, it does not 
change the access of the document in the original 
project. 
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From the [type of filing] Cover Page, you can take 
any of the actions shown below or go directly to 
step 8. 

 

To... Do this... 
 

 

Attach other 

previously filed 

documents to the 

same document 

type 

 

To attach previously 

filed documents to 

a different 

document type 

To detach a file from 

the cover page 

 
 

To add a document 

type that does not 

appear on the list 

Select the document type in the Filing 

Subtype/Document Type list and click 

Duplicate to create a copy of that 

document type in the list. The Attach 

File dialog box displays. Repeat 

steps 3 to 5 

Repeat steps 2 to 5 
 
 
 
 

From the [type of filing] Cover Page 

dialog box, select a document in the 

Filing Subtype/Document Type list and 

click Detach File 

Scroll down the Filing Subtype/ 

Document Type list, select the 

document type Other and click Add 

Document. The Add Document dialog 

box displays. Complete all fields. Click 

either: 

• OK—To return to the [type of filing] 

Cover Page dialog box 

• Add Document—To add a document 

immediately and enter another 

document type 
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8. From the [type of filing] Cover Page, select one of 
the actions below when you have attached all files 
you need to include in your submission. 

 
To… Do this… 

 
 

Select recipient 

agencies 

Do not close the window. See 

“Selecting Recipient Agencies”  
 

 

Submit the project Do not close the window. See 

“Submitting the Project”  

Save the cover 

page information 

on your database 

for later 

submission 

Click Save. The Filing Management 

window displays 
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4.5 Submitting the Project 
 

Once you have completed your cover page, attached 
the files to be sent to the recipient agencies you 
selected, and added your fees, you are ready to 
submit your project. 

 

This section explains how to monitor the status of your 
unsubmitted filings and how to transmit your project. It 
also includes a short description on viewing the status 
of your submitted filings. 

 

Before submitting your project, note the following: 
 

• You should save the project on your local 
workspace before submitting it. The Save button 
becomes available after all the fields in the Issuer 
Information section on the cover page have been 
completed. 

• You can detach files only before submitting the 
project to the SEDAR server. If you want to detach 
a file from a project, follow the procedure for 
attaching files, but from the [type of filing] Cover 
Page dialog box, click Detach File instead of Attach 
File. 

• Ensure that all details of your submission are 
accurate before you send it to the SEDAR server. 

• You can submit the filing from the [type of filing] 
Cover Page dialog box. However, this method does 
not allow you to save the filing in your database 
first. 
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4.5.1 Monitoring the Status of 

Unsubmitted Filings 

You can view the status of your unsubmitted filings in 
the Date column on the Filing Management window. A 
list of statuses is shown below. 

 
Status Indicates that... 

 
 

In Process A new filing was created and stored on your 

database but is not ready for submission to 

SEDAR because: 

• Not all mandatory fields have been completed, 

or 

• The profile used to create it is no longer active 
 

 

Ready All mandatory fields have been completed and 

the filing is ready for submission to SEDAR 
 

 

Resubmit An error occurred during the submission to 

SEDAR or the file transfer was aborted before it 

was completed. See “File Messages”  

 

 

4.5.2 Transmitting the Project 
 

To submit the project: 
 

1. If you are on the Filing Management window, go to 
step 2. 

 

If you are on the project cover page, click Save to 
save the new filing submission in your database, if 
you have not already done so. 
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The Filing Management window re-displays 
showing the filing identified by temporary project 
and submission numbers. 

 
When a new filing is 

submitted, the date and 

time of reception at 

SEDAR (Eastern Time) 

replaces the READY 

status 

 

 
SUB prefix— 

Documents included 

in an additional filing, 

not yet submitted 

 
 
 
 
 

 

2. Select the filing and click Submit. See the table 
below for further instructions based on the type of 
cover page and documents you are using. 

 

If you are filing... This happens... Go to... 
 

 

Filings for which no 

SEDAR or agency fees 

are charged 

The filing is sent 

directly to the 

SEDAR server 

(the Charge 

Summary dialog 

box does not 

display) 

“Viewing 

Completed 

Submissions”  
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If you are filing... This happens... Go to... 
 

 

Any other types of 

filings 

The Charge 

Summary dialog 

box displays (see 

the illustration in 

Step 3) 

Step 4 

 

3. The Charge Summary dialog box displays. 
 
 
 

 
 
 
Before authorizing payment, click  

Print to print this dialog box for  

auditing or other purposes 

 
 

 
 

 
 
 
 
 
In the Agency section, the GST, QST or HST 
columns show the applicable taxes on market 
centre filing fees. The applicable taxes depend on 
the Subject To line of the User Information dialog 
box. For more information, see “Entering Your User 
Information”. 
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Total Agency 

Fees 

Total SEDAR 

System Fees 

=  Agency Fees + GST + QST + HST 
 

=  SEDAR System Fees 

Total Amount 

Payable 

= Agency Fees + SEDAR System 
Fees + 

applicable taxes 

 

4. Complete the Matter Number field if desired. This 
field is optional; it is a number you assign for your 
reference only. 

 

The Matter Number can be a maximum of 20 
characters in any of the following combinations: 

 

• Letters—a to z, upper and lowercase 

• Digits—0 to 9 

• Punctuation—period, hyphen, parentheses. 
 

5. Click Authorize. 

The Total Agency Fees, Total SEDAR System Fees 
and Total Amount Payable fields in the bottom right 
of the dialog box are calculated as shown below. 
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The Payment Authorization dialog box displays. 
 

 

 
6. On the Payment Authorization dialog box, enter the 

required user IDs and passwords and click Pay. 
 

Either of the following occurs: 
 

• If the user IDs are valid, the files are submitted 
to the agencies and the payment instructions to 
the financial institution. 

• If the user IDs are not valid, the SEDAR Filing 
Management dialog box displays. 

 

 
 

Click OK, then enter the correct user IDs 
and passwords and click Pay. Or, if your 
banking authorization user ID and password 
are not set up correctly, contact the CSA 
Service Desk for assistance at 1-800-219-
5381.  
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4.5.3 Viewing Completed Submissions 
 

Completed submissions appear in the Filing 
Management window showing the filing with 
permanent project and submission numbers, and the 
date and time of reception at SEDAR. 

 

Date and time 

(Eastern Time) of 

reception at SEDAR 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

To monitor the status of filings: 
 

1. On the Filing Management window, click Refresh 
List to ensure that the files are up to date, or select 
a filing and click Refresh Project. 

 

2. Click Status. The first status, Filed with SEDAR, is 
automatically set by the server. For more details on 
viewing the status of filings, see “Viewing the 
Status of Filings”. 

 

For information on viewing the status of fee 
payments, see “Viewing the Status of Fee 
Payments”. 
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Chapter 5 

Assigning Secondary 
Filers to a Project 

 
5.1 Overview 

 
SEDAR enables the designation of one primary and 
several secondary filers for any filing. 

 

The primary filer is the filing service subscriber who 
initiates the filing. Secondary filers are all other filing 
service subscribers assigned to that filing. Both the 
primary and the secondary filers can participate 
directly in the filing, which means that a filing can 
comprise many documents which are prepared by 
different filing service subscribers and submitted under 
the same project number. 

 

As a filer, you can create a list of filers from which to 
select secondary filers. As primary filer, you assign 
secondary filers to the filing and determine which of 
the following three functions they can use: View, 
Retrieve or Submit. Agencies can view the list of 
secondary filers and the functions assigned to each 
filer. 

 

To create your list of filers and assign them to filings, 
use the Filer List dialog box. To indicate the functions 
they can use, go to the Secondary Filer Access dialog 
box. The procedures for doing these tasks are in the 
following pages. 
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5.2 Maintaining Your Filer List 
 

In SEDAR, you maintain a general list of filers, much 
like keeping a special address book of filers. As 
primary filer for a project, you select filers from this 
general list to create a list of secondary filers specific 
to the project. 

 

You maintain the general list on your local workspace, 
not in the SEDAR server. Your filer list is independent 
from the secondary filer list you create for a project. 
Consequently: 

 

• You do not submit the general list of filers to the 
SEDAR server. 

• You do not share the general list with any other 
SEDAR users. 

• For every project, you create a specific list of 
secondary filers that you submit to the SEDAR 
server. 

• Changes you make to the information on a filer in 
the general filer list are not automatically made to 
the lists for the projects the filer has been assigned 
to. You must select each associated project and 
update the information on that secondary filer. 

• Deleting filers from the general filer list does not 
delete them from the project lists. 

• You can delete filers from a project list without 
deleting them from the general filer list. 
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5.2.1 Adding Filers to Your Filer List 
 

You can add up to 100 filers to your filer list. 
 

Create your filer list on the Filer List dialog box, which 
you access from the Filing Management window or the 
Secondary Filer Access dialog box. 

 

To add filers to your filer list: 
 

1. On the Filing Management window, select Filer List 
from the Options menu. 
or, 
On the Filing Management window, select a filing 
and select Secondary Filer Access from the View 
menu. When the Secondary Filer Access dialog 
box displays, click Add. 

 

The Filer List dialog box displays. 
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Filer List dialog box 

accessed from the 

Filing Management 

window 

 
Filer List dialog 

box accessed from 

the Secondary 

Filer Access dialog 

box. Note the 

additional 

procedure for 

adding secondary 

filers to projects 

 
 
 
 
 
 

The user ID is 

mandatory 

The name and phone 

number are optional 

 

 

2. Enter the information on the filers you want to add 
to your list in the Add/Modify Filer field. 

 

3. Click Add/Modify. Each filer added is displayed in 
the Filer List field. 

 

4. If you accessed the Filer List dialog box from the 
Filing Management window, click OK to return to 
that window. 
or, 

If you accessed the Filer List dialog box from the 
Secondary Filer Access dialog box, do either of the 
following: 
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• Assign the new filers as secondary filers to the 
project. For more information, see “Adding 
Secondary Filers to a Project”. 

• Click OK to return to the Secondary Filer 
Access dialog box without assigning the new 
filers as secondary filers to the project. 

 

5.2.2 Updating Filer Information in Your 

Filer List 

Update the information on filers in the filer list on the 
Filer List dialog box, which you access from the Filing 
Management window. 

 

Changes made to filers in the Filer List dialog box are 
made to the general list on your local workspace only. 
If you want the changes to be effective for a project, 
you must also make the changes to the project’s 
secondary filer list. For more information, see 
“Updating Secondary Filer Information in a Project”. 

 

To update filer information in your filer list: 
 

1. On the Filing Management window, from the 
Options menu select Filer List. 
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The Filer List dialog box displays. 
 
 

 

 
2. Select the filer you want to modify and enter the 

changes in the Add/Modify Filer field. 
 

3. Click Add/Modify. A message displays asking you if 
you really want to make the changes. 

 

4. Click either: 
 

• Yes—To save the changes. 

• No—To verify that you have made the correct 
changes, then click Add/Modify and Yes. 

 

5. Click OK to return to the Filing Management 
window. 
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5.2.3 Deleting Filers from Your Filer List 
 

You delete filers from your list of filers on the Filer List 
dialog box, which you access from the Filing 
Management window. 

 

To delete filers from your filer list: 
 

1. On the Filing Management window, select Filer List 
from the Options menu. 

 

The Filer List dialog box displays. 
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2. Select the filer you want to delete and click Delete. 
A message displays asking you if you really want 
to delete the selected filer. 

 

 

 
3. Select one of the following: 

 

• Yes—To delete. 

• No—To verify that you have selected the 
correct filer, then click Delete and Yes. 

 

The selected filer is immediately removed from the 
list. 

 

4. Click OK to return to the Filing Management 
window. 
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5.3 About Secondary Filers 
 

You can add up to 50 secondary filers to a project. 
 

As primary filer, you can grant and revoke access to 
secondary filer functions at any time, even while the 
secondary filer is using those functions. 

 

For each filer added, you must determine the functions 
they can use (the default setting is None). The 
definitions and table below will help you understand 
the use of each of function. 

 

• View—Enables the user to see all document titles 
and access, status details, fees, issuer and filer 
profiles, recipients and authorizations, and 
secondary filer access. 

• Retrieve—Enables the user to download filing 
documents for viewing. 

• Submit—Enables the user to transmit filings, make 
fee payments, and update cover pages (contact 
information and other changeable fields), provided 
they were previously granted the additional 
required access. 

 
If you enable the 

secondary filer to use... They can use... 
 

 

View View 
 

 

Retrieve Retrieve 

View 
 

 

Submit Submit 

View 

Retrieve 
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5.3.1 Adding Secondary Filers to a Project 
 

To add secondary filers to a project: 
 

1. On the Filing Management window, select the 
required filing. From the View menu, select 
Secondary Filer Access. 

 

The Secondary Filer Access dialog box displays. 
 

 

 
2. Click Add. 

 

The Filer List dialog box displays. 
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3. Click the check field under the Add column beside 
the filers you want to add to the project and click 
OK. 

 

The Secondary Filer Access dialog box redisplays 
showing the selected filers and their current access 
as None. (If there are no filers in your list, see 
“Adding Filers to Your Filer List” to create a list.) 

 
 
 
 
 
 

From the New Access 

list beside their name, 

select the functions 

you want the 

secondary filer to use 

 
 
 

 
4. For each secondary filer you added, select the 

functions you want them to use from the New 
Access list beside their name (the default setting is 
None). 

 

Note: You can click Cancel before submitting your 
changes to the server to return to the Filing 
Management window without making 
changes. 
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5. Click Submit to send your changes to the server. 
The server is updated immediately and the Filing 
Management window displays. 

 

6. Contact the secondary filer and provide them with 
the following information: 

 

• The project number 

• The user ID 

• The functions they can use. 
 

5.3.2 Deleting Secondary Filers from a 

Project 
 

To delete a secondary filer from a project: 
 

1. On the Filing Management window, select the 
required filing. From the View menu, select 
Secondary Filer Access. 

 
The Secondary Filer Access dialog box displays. 
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2. Click Delete. 
 

The Delete Secondary Filers dialog box displays. 
 

 

 
3. Select the filer you want to delete from the project 

and click OK. A message displays asking you if 
you really want to delete the selected filer. 

 

4. Click either: 
 

• Yes—To delete 

• No—To verify that you have selected the 
correct filers, then click Delete and Yes. 

 

The Secondary Filer Access dialog box re-displays 
showing the updated list of secondary filers. 

 

Note: You can click Cancel before submitting your 
changes to the server to return to the Filing 
Management window without making 
changes. 
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5. Click Submit to send your changes to the server. 

The server is updated immediately and the Filing 

Management  window  displays. 
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5.3.3 Changing the Secondary Filer 

Functions 

At any time, you can change the functions a 
secondary filer can use. For a definition of the 
functions and user access, see “About Secondary 
Filers”. 

 

To change the functions a secondary filer can use: 
 

1. On the Filing Management window, select the 
required filing. From the View menu, select 
Secondary Filer Access. 

 

The Secondary Filer Access dialog box displays. 
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2. Select the desired filer, then the function you want 
them to use from the New Access list beside their 
name. 

 

Note: You can click Cancel before submitting your 
changes to the server to return to the Filing 
Management window without making 
changes. 

 

3. Click Submit twice to send your changes to the 
server. The server is updated immediately and 
the Filing Management window displays. 

 

5.3.4 Updating Secondary Filer 

Information in a Project 

You can update the information (name and phone 
number) of a secondary filer in a project through the 
Filer List dialog box. 

 

Changes made to filers in the Filer List dialog box are 

made to the general list on your local workspace only. 
For the changes to be effective for a project, you must 
also make the changes to the project’s secondary filer 
list. 

 

To update the information on a secondary filer in a 
project: 

 

1. On the Filing Management window, select the 
required filing. From the View menu, select 
Secondary Filer Access. 

 
The Secondary Filer Access dialog box displays. 
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2. Click Add. 

 
The Filer List dialog box displays. 

 

 

 
3. In the Filer List field, select the secondary filer for 

whom you want to change the information and 
update the information in the Add/Modify Filer field. 

 

4. Click Add/Modify. A message displays asking if you 
really want to save your changes. 

 

5. Click either: 
 

• Yes—To save 

• No—To verify the information you have 
changed, then click Add/Modify and Yes. 
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The changes display in the Filer List field. 
 

 

 
6. Click OK. A message displays asking you if you 

want to replace the secondary filer information, 
since the filer you want to add is already assigned 
to a project. 

 

7. Click either: 
 

• Yes—To replace the information in the project 

• No—To keep the current information in the 
project filer list (the changes are still made in 
the Filer List dialog box). 

 

The Secondary Filer Access dialog box displays 
with or without the changes, depending on the 
action you took. 
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8. Click either: 
 

• Submit (twice) —To submit the changes to 
the server. The server is updated 
immediately and the Filing Management 
window displays. 

• Cancel—To return to the Filing Management 
window without updating the information on the 
secondary filer for that project (the changes 
made to that filer in the general filer list are 
saved). 

 

9. If you want to update the information on the 
secondary filer in other projects they were 
assigned to, repeat this procedure for each project. 
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5.4 Accessing a Project as a Secondary Filer 
 

When informed by the primary filer that your 
organization is a secondary filer for a project: 

 

• Write down the project number and the user ID 
assigned to the filing 

• Download the new project 

• Verify the functions you are allowed to use for that 
project. 

 

5.4.1 Downloading a New Project 
 

Before you can contribute to the project, you must 
have it in your list of filings. To make the project 
display in your list of filings, follow the procedure 
below. 

 
 

Ensure that you have logged in with the user ID 
assigned by the primary filer. 
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1. On the Filing Management window, from the 
Options menu select Quick Search Inquiries. 
The Quick Search Inquiries dialog box displays. 

 

 

 
2. Verify if there is an inquiry in the list that will 

retrieve the new project. 
 

If there is, go to step 3. 
 

If there is not, click New to create the appropriate 
search inquiry. 

 
The Quick Search Inquiries wizard displays. Follow 
the instructions on the screen or see “Using the 
Quick Search Inquiries Function”. 
When done go to step 3. 

 

3. Click Refresh List. The information on all filings in 
the list is updated and the Filing Management 
window re-displays showing the new project. 
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5.4.2 Verifying the Functions You Can Use 
 

Before you access the project for the first time to view, 
retrieve or submit files, verify what functions you are 
allowed to use. This way, you will not waste time trying 
to use a function you are not allowed to use. For 
example, if you submit a file to be added to the project 
for which you cannot use the Submit function, the 
server will load the entire file before rejecting it and 
telling you that you cannot use that function for the 
project. 

 

To find out what functions you can use: 
 

1. On the Filing Management window, select the 
required filing. 
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2. On the View menu, Select Secondary Filer Access. 

 
The Secondary Filer Access dialog box displays 
showing the list of all secondary filers for the 
project selected and the functions they can use. 

 

 

 
If the primary filer has assigned to you one of the 
View, Retrieve and Submit functions, the access 
you have remains the same for all submissions you 
make for the project. For example, if you have 
access to the Submit function for project 01001032 
you can submit documents and fees for that project. 
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Chapter 6 

Modifying a Submitted 
Project 

 
6.1 Overview 

 
After you have submitted a filing to the server, you can 
add to it by submitting documents, recipient agencies 
(only when you are adding documents) and fees to the 
server. These additions are all part of the same project 
and have the same project number assigned to them. 

 
 

You can add documents to filings created for the 
category of filer Other Issuers or Investment Fund 
Issuers, even if the issuer has ceased reporting since 
the initial submission was made. 
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6.2 Adding Documents and Formal Correspondence 
 

Whenever you add documents or formal 
correspondence to an existing filing, it generates a 
new submission number that is displayed in the list of 
submissions on the Filing Management window. The 
project number, filer name and list of documents for 
the category of filing and the recipient agencies have 
already been captured by SEDAR when the new 
project was submitted. 

 

You can attach a new document, a previously filed 
document or formal correspondence to your filing. 

 

See the table below to find out which procedure you 
should follow. 

 
To attach... See... 

 
 

A new document “Adding a New Document”  
 

A previously filed document “Adding Previously Filed 

Documents”  
 

 

Formal correspondence “Adding Formal 

Correspondence”  

 

 

6.2.1 Adding a New Document 
 

To add documents to a filing: 
 

1. On the Filing Management window, select the filing 
you want to add files to. 
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2. On the File menu, select Add to a Filing, then 
Documents. 

 

The [type of filing] Cover Page dialog box displays. 
 

 

 
3. Select a document type. (If you select the 

document type Other, the Add Document button 
becomes available.) 

 

4. Depending on the type of document you select, do 
either of the following: 

 

• Click Attach File. The Attach File dialog box 
displays. Go to step 6. 

• Click Add Document. The Add Document dialog 
box displays. Go to step 5. 
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5. Enter the required information and click Attach File. 

 
The Attach File dialog box displays. 

 

 
 

6. Select the following: 
 

• The location of the file you want to attach (PC 
workspace or SEDAR workspace) 

• The file type 

• The drive 

• The directory 

• The name of the file, with the accepted 
extension. 

 

Note: If you want to attach a file from your SEDAR 
workspace and want to view the most up-to- 
date files, click Refresh List to connect to 
SEDAR. 

 

7. After you select the file, click OK. 
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If you attempt to send a file which contains 
annotations, such as attached files or embedded 
objects, the following message displays: 

 
“The file cannot contain annotations (attached files 
or embedded objects). Please remove them and 
resave the file.” 

 
Follow the instructions in the message. For more 
information, see “File Messages”. 

 

Depending on the type of document you select, 
either of the following occurs: 

 

• The [type of filing] Cover Page dialog box 
re-displays with the file attached. 

• The Add Document dialog box displays. Click 
OK. The [type of filing] Cover Page dialog box 
re-displays with the file attached. 

 

The Agencies, Detach File and Duplicate buttons 
become available. 

 

If a message displays, follow the instructions in the 
message. For more information, see “File 
Messages”. 
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You can take any of the actions shown below or go 
directly to step 8. 

 

To... Do the following... 
 

 

Attach many files 

to the same 

document type 

 
 

To attach files to a 

different 

document type 

To detach a file 

from the cover 
page* 

Select the document type in the Filing 

Subtype/Document Type list and click 

Duplicate to create a copy of that 

document type in the list. Repeat 

steps 6 and 7 

Repeat steps 3 to 7 
 
 
 

From the [type of filing] Cover Page 

dialog box, select a document in the 

Filing Subtype/Document Type list and 

click Detach File. The file is detached 

and removed from the list on the [type 

of filing] Cover Page 

 

* Only files which have not been submitted to the 

SEDAR server can be detached from a project. 
 

Note: Remember that in SEDAR, one paper 
document corresponds to one electronic file. 
You cannot submit the electronic equivalent 
of one paper document in more than one 
electronic file. For more information, refer to 
the SEDAR Filer Manual. 
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8. After you have attached the files, select one of the 
actions below. 

 
To… Do the following… 

 
 

Modify the cover 

page 

 

Add recipient 

agencies 

Do not close the dialog box. See 

“Modifying Cover Pages”  

 

Click Agencies. The Add a Recipient 

Agency dialog box displays. See 

“Adding Recipient Agencies to a 

Submitted Filing”  
 

 

Add fees If there are additional fees, add the 

fees before submitting the filing (for 

more information, see “Adding 

Fees”) 

Save the cover 

page information 

on your database 

for later 

submission 

Submit the filing to 

SEDAR now 

without adding 

fees or saving the 

filing first 

Click Save. The Filing   Management 

window displays 

 
 
 

Click Submit. The document is sent 

to the SEDAR server. 

Depending on the document type 

selected, the Submit button 

becomes available only after you 

have entered the applicable fees 

 

Once submitted, the filing displays in the list of 
submissions on the Filing Management window. 
The filing in the list bears the same project number 
as the original filing, but has its own unique 
submission number. 
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6.2.2 Adding Previously Filed Documents 
 

It is possible to reuse certain documents already 
submitted to SEDAR. For example, in the case of a 
take-over bid filing, as the filer, you may want to use 
the issuer’s financial statements to submit to agencies. 

 

The filings you are allowed to search in for documents 
are restricted to the filings associated with the profile 
number of the issuer for the filing you are creating. On 
the SEDAR server, you can search on this issuer’s: 

 

• Public filings 

• Private filings for which you are the primary filer or 
a secondary filer with the Retrieve and Submit 
privilege. 

 

You cannot reuse documents sent as formal 
correspondence or with one of the following private 
access levels: 

 

• Private – Draft 

• Private – Virus 

• Private – Incorrect Filing 

• Private – Incorrect Format 

• Private – Nonpublic 

• Private – Nonpublic – Incorrect. 
 

Before the implementation of Release 6.0, accepted 
file formats were: 

 

• For WordPerfect documents – .w51, .w52, .w60 
and .w61 
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• For Word for Windows – .doc 

• For PDF documents – .pdf. 
 

You can attach a pre-release 6.0 document saved in 
any of these formats since the document on the 
SEDAR server is the same as the original one and is 
not actually resubmitted to the server. 

 

To attach a previously filed document: 
 

1. On the Filing Management window, select the filing 
you want to add files to. 

 

2. On the File menu, select: 

Add to a Filing > Documents. 

The [type of filing] Cover Page dialog box displays. 
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3. Select the document type in the Filing Subtype/ 
Document Type field. (If you select the document 
type Other, the Add Document button becomes 
available.) 

 

4. Depending on the type of document you chose, do 
either of the following: 

 

• Click Attach File. The Attach File dialog box 

displays. Go to step 6. 

• Click Add Document. The Add Document dialog 
box displays. Go to step 5. 

 

5. Enter the required information and click Attach File. 
The Attach file dialog box displays. 

 

6. Click Previously Filed Documents. 

 
The Previously Filed Projects/Documents section 
displays on the Attach File dialog box. 
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7. Click Search. 
 

The Search for Previously Filed Documents dialog 
box displays. 

 
SEDAR displays only the 

documents associated with 

that profile number. In the 

case of an Investment Fund 

Issuer filing, the profile 

number used is that of the 

Investment Fund Group 

 
The date range fields are 

unavailable when you enter 

a project number 

 
8. To narrow your search, you can: 

 

• Enter a project number 

• Select a Category of Filing or a Filing Type, or 
both. You can also change the Date range if 
desired (the default is one year). 

 

9. Click Submit. 
 

After the search is complete: 
 

• If there are no projects matching your search 
criteria, the Search for Previously Filed 
Documents dialog box re-displays. Change 
your search criteria or click cancel to return to 
the Attach File dialog box. 
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• If there are filings matching your search criteria, 
the Attach File dialog box displays listing the 
search results. 

 

 

The Path and File are 

automatically updated 

 
 
 

 
Expand the folder to display 

each document 

 
 
 
 
 

The list of projects and documents displayed 
remains available until you save, submit or cancel 
the submission from the cover page. 

 

10. Select the document to attach and click OK. 
Depending on the type of document you select, 
either of the following displays: 

 

• The [type of filing] Cover Page re-displays with 
the file attached. 

• The Add Document dialog box displays. Click 
OK. The [type of filing] Cover Page dialog box 
re-displays with the file attached. 

 

The Agencies, Detach File and Duplicate buttons 
become available. 
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The access level of the newly attached document is 
private, regardless of its access level in the original 
project, until an agency changes the access level in 
the current project. 

 
The exception is for continuous disclosure filings 
(other than the filing types “Other Filings”, “Personal 
Information Form and Authorization 51-105F3A”, 
“Personal Information Form and Authorization 51-
105F3B” and “For Regulator’s Use Only”) and 
exempt market offerings and disclosure filings 
(other than “Schedule 1 of report of exempt 
distribution (45-106F1) and “Schedule 1 of report 
of exempt distribution Form 5”), as described in 
the SEDAR Filer Manual,) which are automatically 
made public upon submission to SEDAR. 

 
If an agency changes the access to this document 
in your current project, it does not change the 
access of the document in the original project. 

 

You can take any of the actions shown below or go 
directly to step 11. 

 

To... Do the following... 
 

 

Attach many files 

to the same 

document type 

 
 

To attach files to a 

different 

document type 

Select the document type in the Filing 

Subtype/Document Type list and click 

Duplicate to create a copy of that 

document type in the list. Repeat 

step 10 

Repeat steps 3 to 10 
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To... Do the following... 
 

 

To detach a file 

from the cover 

page* 

From the [type of filing] Cover Page 

dialog box, select a document in the 

Filing Subtype/Document Type list and 

click Detach File. The file is detached 

and removed from the list in the [type 

of filing] Cover Page 
 

* Only files which have not been submitted to the 

SEDAR server can be detached from a project. 
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11. After you have attached the files, select one of the 
actions below. 

 
To… Do the following… 

 
 

Modify the cover 

page 

 

Add recipient 

agencies 

Do not close the window. See 

“Modifying Cover Pages”  

 

Click Agencies. The Add a Recipient 

Agency dialog box displays. See 

“Adding Recipient Agencies to a 

Submitted Filing”  
 

 

Add fees If there are additional fees, add the 

fees before submitting the filing (for 

more information, see “Adding 

Fees”) 

Save the cover 

page information 

on your database 

for later 

submission 

Submit the filing to 

SEDAR now 

without adding 

fees or saving the 

filing first 

Click Save. The Filing Management 

window displays 

 
 
 

Click Submit. The document is sent to 

the SEDAR server. For more 

information on the transmission 

process, see “Transmitting the 

Project”  

Depending on the document type 

selected, the Submit button becomes 

available only after you have entered 

the applicable fees 
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6.2.3 Adding Formal Correspondence 
 

You cannot add a recipient agency to a submission 
when adding formal correspondence using the 
following method. To add an agency to the list, see 
“Adding Recipient Agencies to a Submitted Filing”. 

 

To add formal correspondence to a filing: 
 

1. On the Filing Management window, select the filing 
you want to add files to. 

 

2. On the File menu, select Add to a Filing, then 
Formal Correspondence. 

 
The Formal Correspondence dialog box displays. 

 

 
 

3. Select a document type. (If you select the 
document type Other, the Add Document button 
becomes available.) 
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4. Depending on the type of document you chose, do 
either of the following: 

 

• Click Attach File. The Attach File dialog box 
displays. Go to step 6. 

• Click Add Document. The Add Document dialog 
box displays. Go to step 5. 

 

5. Enter the required information and click Attach File. 
The Attach File dialog box displays. 

 

6. Select the following: 
 

• The location of the file you want to attach 
(PC workspace or SEDAR workspace) 

• The file type 

• The drive 

• The directory 

• The name of the file with the .pdf extension. 
 

If you select to attach a file from your SEDAR 
workspace and want to view the most 
up-to-date files, click Refresh List to connect to 
SEDAR. 

 

After you select the file, click OK. 
 

If you attempt to send a file which contains 
annotations, such as attached files or embedded 
objects, the following message displays: 

 

“The file cannot contain annotations (attached files 
or embedded objects). Please remove them and 
resave the file.” 
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Follow the instructions in the message. 

 
The Formal Correspondence dialog box displays 
and the Submit and Detach File buttons become 
available. 

 

If a message displays, follow the instructions in the 
message. For more information, see “File 
Messages”. 

 

You can take any of the actions shown below or go 
directly to step 7. 

 

To... Do the following... 
 

 

To attach files to a 

different 

document type 

Repeat steps 3 to 6 

 
 

To detach a file From the Formal Correspondence 

dialog box, select a document in the 

Filing Subtype/Document Type list and 

click Detach File. The file is detached 

and removed from the list 

 
* Only files which have not been submitted to the 

SEDAR server can be detached from a project. 

 

Note: Remember that in SEDAR, one paper 
document corresponds to one electronic file. 
You cannot submit the electronic equivalent 
of one paper document in more than one 
electronic file. For more information, refer to 
the SEDAR Filer Manual. 
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7. After you have attached the files, click Submit. The 
document is sent to the SEDAR server. For more 
information on the transmission process, see 
“Transmitting the Project”. 

 

Once submitted, the filing displays in the list of 
submissions on the Filing Management window. 
The filing in the list bears the same project number 
as the original filing, but has its own unique 
submission number. 
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6.3 Modifying Cover Pages 
 

Once a filing has been submitted, you can modify 
information on page 2 of the Investment Funds, 
General Investment Funds, General, Issuer and Issuer 
(Annual Information Form) cover pages. 

 

There are two ways you can access the cover page of 
a submitted filing to modify information: using the Add 
to a Filing option on the File menu or the Cover Page 
option on the View menu. 

 

6.3.1 Using the Add to a Filing Option 
 

1. On the Filing Management window, select a filing. 
On the File menu, select Add to a Filing, then 
Documents. 

 
The [type of filing] Cover Page dialog box displays. 

 

2. Modify the information as required. 
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The modifiable cover page types and fields are listed 
in the following table: 

 
Cover Page 

Type Modifiable Fields 
 

 

General •   Contact Information 

• Continuous Disclosure Rule 

• Financial Period Ended 

• Financial Period Date Relates to  

• Date of Meeting 

• Date of Meeting  Relates to 

• Confirmation that schedule 1 was 
prepared using the template available on 
www.sedar.com 

• Warning to remove Schedule 1 from the 
report of exempt distribution 

General 

Investment 

Funds 

 
 

 
 

 

 

 

 

Investment 

Funds 

• Contact Information 

• Financial Period Ended 

• Financial Period Date Relates to 

• Date of Meeting 

• Date of Meeting Relates to 

• Confirmation that Schedule 1 was 
prepared using the template available on 
www.sedar.com 

• Warning to remove Schedule 1 from the 
report of exempt distribution 

• Contact Information 

 
 

Issuer •   Contact Information 

• Type of Securities 

• Initial Public Offering 

• Primary Offering 

• Secondary Offering 

• MJDS offering in the United States 

• Inclusion of Future Oriented Financial 

Information (“FOFI”) 

• Aggregate Gross Proceeds 

• Underwriter Info – Underwriter name 

(E) and (F) 

• Underwriter Info – Underwriter 

Counsel (all fields) 

• Promoter Info (all fields) 

Third Party •  Contact Information 

http://www.sedar.com/
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3. Select a document type and a file, and click Attach 
File. 

 

4. Continue adding files to a filing following the usual 
procedures. 
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6.3.2 Using the Cover Page Option 
 

1. On the Filing Management window, select a filing 
for which you want to modify the cover page. From 
the View menu, select Cover Page. 

 

The [type of filing] Cover Page dialog box for the 
selected filing displays, showing any previously 
saved information. 

 

2. Modify the information as required. See the table in 
“Using the Add to a Filing Option” for a list of 
modifiable cover pages and fields. 

 

3. When all modifications have been made, click 
either of the following: 

 

• Submit—To send the changes to the SEDAR 
server and update the information in your local 
workspace. 

• Cancel—To remove any changes you made to 
the cover page and return to the Filing 
Management window. 

 
 

You cannot add recipients, add or modify fees, save 
the information or modify documents from the 
Cover Page option on the View menu. To add or 
modify fee amounts, use the Fees function on the 
View menu. To add recipient agencies, use the Add 
to a Filing > Document function on the File menu. 
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6.4 Adding Recipient Agencies to a Submitted Filing 
 

The types of agencies available for a project are 
determined by the filing type. Therefore, once a project 
has been submitted to a type of agency, you can 
submit it to additional agencies of the same type only. 
For example, you cannot add a market centre to a 
project if its original recipient agency type was 
commissions. To send the documents to a recipient 
agency of a different type, you must create a new 
project and select the appropriate filing type in the 
appropriate folder. 

 

To add recipient agencies: 
 

1. Open the Filing Management module. Select the 
filing from the list of submissions to which you want 
to add agencies and on the File menu, point to Add 
to a Filing and click Documents. The [type of filer] 
Cover Page displays. 

 

2. To add more agencies, click Agencies. The 
Agencies dialog box displays. 

 

3. Click Add. The Add a Recipient Agency dialog box 
displays listing the available agencies. 
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Depending on your category of filer, the category of 
filing and the type of filing, and the folder in which it 
is located, one of the following displays in the 
Agency Type field: 

 

• Commissions 

• Market Centres (Exchanges) 

• Commissions and Market Centres 

(Exchanges). 
 

The Test Filing option is always shown. 
 
 
 
 

The Agency Type field is 

not available because you 

cannot modify the agency 

type once the filing has 

been submitted. To 

change the agency type, 

you must create a new 

project 
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4. In the Agency field, select any additional agencies 
and click OK. 

 

The Recipient Agencies dialog box re-displays with 
the additional agencies listed. 

 

 

 

 
5. Select one of the following actions: 

 

Click… To… 
 

 

OK Go back to the cover page. Go to step 6 
 

 

Add Send the filing to more agencies 
 

 

Delete Delete agencies that you just selected to 

receive the filing; agencies cannot be 

deleted once the filing has been 

submitted 
 

 

Click Email ID Include the SEDAR e-mail ID of the 

contact person at the agency, if 

applicable, who can be contacted by the 

filer using SEDAR e-mail when the filing 

is received by an agency 
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6. On the [type of filer] Cover Page, highlight the 
document type “Letter concerning recipient 
agency” and click Attach File (see “Attaching a 
File”). 

 
Once the document has been attached, the Submit 
button will be highlighted on the Cover Page 
screen. 

 

7. Click Submit to send this project to the additional 
recipient agency. 

 

Note: Only certain filing types provide the 
document type noted above. If you are 
adding a recipient agency to a filing that 
does not provide this document type, 
select the document type “Cover letter.” 

 

Note: All documents previously submitted on the 
project will be available to the newly added 
recipient agency. It is not necessary to 
re-attach all documents submitted with the 
initial filing of this project. 
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6.5 Adding Fees 
 

You can add fees to a project that has already been 
submitted to the server. 

 

To add fees to a submitted filing: 
 

1. Open the Filing Management module and select 
the project from the list of submissions to which 
you want to add fees. 

 

2. On the View menu, select Fees. One of the 
following occurs: 

 

• If fees have been submitted, the Summary of 
Filing Fees dialog box displays, showing the 
total project fees submitted to date, including 
both agency filing fees and SEDAR System 
fees (SEDAR System fees do not apply to 
most documents). 

Go to step 3. 

• If no fees have been submitted, the Add/Modify 
dialog box displays. 

Go to step 4. 
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3. On the Summary of Filing Fees dialog box, select 
Add/Modify. 

 

The Add/Modify Fees dialog box displays. 
 
 

 

 

4. Select the agency to which you want to submit 
fees. 

 

For commissions and market centres, a fee 
schedule for that organization displays. 

 

5. Enter the fee amount in the Amount$ column 
beside the corresponding fee description. The GST 
and QST or HST, if applicable (no taxes are paid on 
filings sent to commissions and on test-filings), are 
calculated automatically. Select the next recipient 
agency, if applicable, and repeat this process for all 
intended agencies. 
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When fees have been 

submitted to SEDAR, you 

can view the status of fees 

for the project by clicking 

Payment Status Detail 

 
You can change the size of 

columns on the Payment 

Status Detail dialog box, 

and print the dialog box for 

audit purposes 

6. When done, click OK. The Summary of Filings 
Fees dialog box displays showing the fees in the 
WIP (work in progress) field, in both the Total 
Project Fees and Agency Fees sections. 

 
 
 
 
 
 

7. Do one of the following: 
 

• To add more fees, click Add/Modify, and repeat 
steps 4 to 6. 

• To delete fees, click Add/Modify. Follow steps 4 
to 6, but delete the fees in the Amount$ 
column, instead of entering them. 

Note: You cannot delete fees that have 
already been submitted to the server. 

• To submit the fees once the required fees have 
been entered, go to step 8. 
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8. Click Submit. The Charge Summary dialog box 
displays showing the added fees entered per 
recipient agency. The SEDAR System Fees field 
will indicate $0.00. If additional SEDAR System 
Fees are due, click within this field and enter the 
amount. 

 
 
 
 
 
 
 
 
 
 

 
The QST and HST fields 

only display if applicable 

 
 
 

 

Note: SEDAR System Fees are determined by the 
filing type, subtype and number of recipients. 
GST and QST or HST are calculated on 
market centre filing fees depending on your 
location. For more information, see 
“Entering Your User Information”. 

 
Adding more fees to an existing project does 
not generate a separate submission for the 
project, but simply adds to the cover page 
information for that project. 
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9. Click Authorize to submit the fees. 
 

The Payment Authorization dialog box displays. 
 

 
 

10. Enter the required user IDs and passwords and 
click Pay. 

 

• If the user IDs and passwords are valid, the 
files are submitted to the agencies and the 
payment instructions to the financial institution. 

• If the user IDs and passwords are not valid, the 
SEDAR-Filing Management dialog box 
displays. 

 

 

Click OK, then enter the correct user IDs 
and passwords and click Pay. Or, if your 
banking authorization user ID and password 
are not set up correctly, contact the CSA 
Service Desk for assistance at 1-800-219-
5381.  

The SEDAR File Transfer dialog box displays 
while the files are being submitted to the 
agencies and the payment instructions sent to 
the financial institution. 
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Chapter 7 

Monitoring the Progress 
of Projects 

 
7.1 Overview 

 
When you submit a project to SEDAR, it is moved to 
the recipient agencies’ space in the SEDAR database 
to be retrieved by the commissions and market 
centres you selected as recipients. 

 

Commissions and market centres review an electronic 
filing in the same way they review a paper filing. 
Therefore, you monitor the status of your electronically 
submitted projects the same way you would follow up 
on projects submitted in paper form. 

 

To monitor the progress of a project, use the Filing 
Management module to: 

 

• Populate your list of filings 

• Customize your view of the list of filings 

• Refresh your filing list 

• View the access level of documents 

• View the status of filings 

• Retrieve formal correspondence 

• View the status of fee payments. 
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7.2 Using the Quick Search Inquiries Function 
 

To populate the list of filings appearing in the Filing 
Management window, you create search inquiries and 
send them to the SEDAR server to search the filings 
database. A search inquiry consists of a combination 
of fields, operators and criteria that you define in 
SEDAR using the Quick Search Inquiries or the 
Advanced Inquiries function (for more information, see 
“About Fields, Operators and Criteria”). 

 

The Quick Search Inquiries function uses a wizard to 
help you easily create most of the inquiries you need 
to complete your daily tasks. It is recommended to use 
this function for quick retrieval of filings. 

 

The Advanced Inquiries function (formerly the 
Customize List function) enables you to create 
customized searches for special needs; use it only if 
the Quick Search Inquiries function does not give you 
the required results. For more information on this 
function, see “Using the Advanced Inquiries 
Function”. 
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About the Quick Search Inquiries Dialog Box 
 

The Quick Search Inquiries dialog box is divided into 
three sections as indicated in the illustration below. 

 

 

Delete selected 

inquiry 

 
Change 

selected inquiry 

name 

 
Modify criteria 

 
Create new 

inquiry (wizard) 

 
Select default 

inquiry 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Update list of filings in 

Filing Management 

window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Close the dialog box 

 
Save by 

replacing 
 

Save by 

creating new 

inquiry 
 

Exit the 

notebook 

without saving 

any changes 

 
 
 

Get help 

on dialog box 

 

 

For information on creating search inquiries, see 
“About the Quick Search Inquiry Wizard”. 
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For a summary of the actions you can take from each 
section, see the following table. 

 

To... Do the following... 
 

 

Modify an inquiry 1. Select the inquiry to modify. 

2. Click Change or type ALT+C. The Inquiry Criteria notebook 

displays on the right of the dialog box. 

3. Make the changes and click Save or Save As. 

4. Click Close to return to the Filing Management window or 

Refresh List to refresh the list of filings in the Filing 

Management window. 
 

Rename an inquiry 1. Select the inquiry to rename. 

2. Click Rename or type ALT+M. The Inquiry Criteria notebook 

displays on the right of the dialog box. 

3. Type the new name and click Save or Save As. 

4. Click Close to return to the Filing Management window or 

Refresh List to refresh the list of filings in the Filing 

Management window. 
 

Delete an inquiry 1. Select the inquiry to delete. 

2. Click Delete or type ALT+D. 

3. Click Close to return to the Filing Management window or 

Refresh List to refresh the list of filings in the Filing 

Management window. 
 

Create an inquiry 1. Click New or type ALT+N. The Quick Search Inquiries 

wizard application launches. 

2. Follow the instructions in the dialog boxes or see “About 

the Quick Search Inquiry Wizard”. 

Select an inquiry as the 
default inquiry 

1. Select the inquiry you want to use as the default inquiry. 

For more information, see “Default Inquiry for the Refresh 

List Function”. 

2. Click Default or type ALT+F. 

3. Click Close to return to the Filing Management window or 

Refresh List to refresh the list of filings in the Filing 

Management window. 
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To... Do the following... 
 

 

Close the notebook Click Cancel. No changes are saved and you remain on the 

Quick Search Inquiries dialog box. 
 

Close the entire dialog box Click Close. No changes are saved, unless previously saved 

in the notebook, and you return to the Filing Management 

window. 

 

Default Inquiry for the Refresh List Function 
 

The Refresh List function, accessible on the Filing 
Management window, is a quick way to update the 
information on the list of filings on your Filing 
Management window. 

 

This function sends the default inquiry of your choice 
to the server. To select the default inquiry, you must: 

 

• Select Quick Search Inquiry as your default search 
method in the User Profile and Defaults dialog box 
(see “Setting Up SEDAR”) 

• Select one of the inquiries in your list of inquiries as 
the default. 

 
About the Quick Search Inquiry Wizard 

 
The Quick Search Inquiry function uses a wizard to 
help you build search inquiries quickly and effortlessly. 
The Quick Search Inquiry wizard is launched 
automatically the first time you access SEDAR. 
Thereafter, you launch it from the Quick Search 
Inquiries window which is accessed from the Options 
menu. 
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Here are a few things that are useful to know about the 
wizard: 

 

• To bypass the welcome page, click Don’t Show 
This Page Again at the bottom of the welcome 
page. 

• To stop creating an inquiry at any time and return 
to the Filing Management window, click Cancel. 

• To return to the previous window, click Back. 

• To go to the next window, click Next. 

• For help on the window, click Help. 
 
 
 
 
 
 
 

 
Click here if you 

don’t want to 

view this window 

next time you 

open the wizard 

 
 

Return to 

previous page; 

greyed out on the 

first page 

 
 

Move to the next 

page; greyed out on 

last page 

 
 

Stop building the 

inquiry and return to 

the Filing Management 

window 

 

Obtain 

online help 

about this 

window 
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To populate your list of filings using the Quick Search 
Inquiries function: 

 

1. On the Filing Management window, from the 
Options menu select Quick Search Inquiries. One 
of the following windows displays: 

 

• If you are building a search inquiry for the first 
time, the Quick Search Inquiry Wizard welcome 
window displays (see illustration above). Read 
it and click Next. 

• If this is not the first time you are building an 
inquiry using the wizard, the Quick Search 
Inquiries dialog box displays. Click New to start 
the wizard. 

 
The Quick Search Inquiry Wizard displays. 
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2. To select the filings that you want to retrieve, follow 
the instructions below. 

 

To retrieve filings by 
 

Click... See... 
the...  

Date the submissions were Date and “Retrieving 
made or the date the filings Next Filings by 
were last updated  Date”  

   

Project Number Project 
Number and 
Next 

“Retrieving 
Filings by 
Project 
Number”  

   

Profile number, Investment Profile “Retrieving 
fund group number, issuer/ Details and Filings by 
filer name or investment 
fund group name 

Next Profile 
Details”  

   

Category of filing, filing Filing Details “Retrieving 
type or filing subtype and Next Filings by 

Filings 

  Details”  
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7.2.1 Retrieving Filings by Date 
 

1. On the Retrieve by Date dialog box, click the date 
by which you want to retrieve filings and click Next. 

 
 

The date is changed when     

a submission or fee 

instructions are added to 

the project or when the 

cover page, the status of 

the filing or the access to a 

document is changed 

 
 
 
 
 
 

The Select a Date Range dialog box displays. 
 

 

 
2. Enter the date from which you want to retrieve your 

filings and click Next. The final dialog box displays. 
For instructions on the final dialog box, see 
“Completing the Search Inquiry”. 
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7.2.2 Retrieving Filings by Project Number 
 

1. On the Retrieve by Project Number dialog box, 
enter the project number of the projects that you 
want to see in your Filing Management window. 

 

 

 
Follow these guidelines: 

 

• Maximum of 100 numbers. 

• Leading zeros of the project number are not 
required. 

• May be individual numbers, separated by a 
comma 

• May be a range of numbers separated by a 
hyphen (for example, 16500–16600). 

 

2. When done, click Next. The final dialog box 
displays. For further instructions on the final dialog 
box, see “Completing the Search Inquiry”.  
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7.2.3 Retrieving Filings by Profile Details 
 

On the Retrieve by Profile Details dialog box, the 
Retrieve By list field offers six criteria to build your 
inquiry, as indicated in the illustration below. 

 

 

 
The table below indicates under which subheading 
you will find instructions on how to build your inquiry 
with these criteria. 

 
To use a... See... 

 
 

Number “Profile or Investment Fund Group Number”  
 

Name “Issuer/Filer or Investment Fund Group 
Name”  
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Profile or Investment Fund Group Number 
 
 
 
 
 
 
 
 
 
 

 

Click to also 

retrieve 

filings 

submitted by 

previous 

issuers 

 
 
 

1. On the Retrieve by Profile Details dialog box, 
select Profile Number or Investment fund group 
number and enter the numbers you want to include 
in the search (maximum of 100, separated by a 
semicolon). 

 

2. When done, click Next. The Select a Date Range 
dialog box displays. For an illustration, see 
“Retrieving Filings by Date”. 

 

3. Enter the date from which you want to retrieve your 
filings and click Next. The final dialog box displays. 
For instructions on the final dialog box, see 
“Completing the Search Inquiry”. 
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Issuer/Filer or Investment Fund Group Name 
 
 
 

 
Only one name can 

be used per inquiry 

 

 
When you search by 

Issuer/Filer name, you 

can click here to also 

retrieve filings 

submitted by previous 

issuers 

 

1. On the Retrieve by Profile Details dialog box, in the 
Retrieve By field select one of the following: 

• Issuer/filer name (English) 

• Issuer/filer name (French) 

• Investment Fund Group name (English) 

• Investment Fund Group name (French) 
 

2. In the Enter a name field, enter or select a name. 

Follow these guidelines: 

• Use only one name per inquiry. 

• Type an asterisk as a wildcard character 
anywhere in the name, except at the beginning. 

3. When done, click Next. The Select a Date Range 
dialog box displays. For an illustration, see 
“Retrieving Filings by Date”. 
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4. Enter the date from which you want to retrieve your 
filings and click Next. The final dialog box displays. 
For further instructions on the final dialog box, see 
“Completing the Search Inquiry”. 

 

7.2.4 Retrieving Filings by Filings Details 
 

On the Retrieve by Filings Details dialog box, the 
Retrieve By list field offers three criteria to build your 
inquiry. The table below indicates what subsection to 
go to for instructions depending on the criterion 
selected. 

 

 
 
 
 

To use the... See... 
 

 

Category of filing “Searching by Category of Filing”  

Filing type “Searching by Filing Type” Filing 

subtype “Searching by Filing Subtype”  
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Searching by Category of Filing 
 

1. On the first Retrieve by Filing Details dialog box, 
select Category of Filing in the Retrieve By list. 

 
The Criteria field displays in the dialog box. 

 

 

 
2. Under Criteria, click the required category and click 

Next. 
 

The Select a Date Range dialog box displays. For 
an illustration, see “Retrieving Filings by Date”  

 

3. Enter the date from which you want to retrieve your 
filings and click Next. 

 

The final dialog box displays. For instructions on 
the final dialog box, see “Completing the Search 
Inquiry”. 
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Searching by Filing Type 
 

1. On the Retrieve by Filing Details first dialog box, 
select Filing Type in the Retrieve By list. 

 
The Criteria field displays in the dialog box. 

 

 

 
2. Under Criteria, click the required filing types and 

click Next. 

 
The Select a Date Range dialog box displays. For 
an illustration, see “Retrieving Filings by Date”. 

 

3. Enter the date from which you want to retrieve your 
filings and click Next. 

 
The final dialog box displays. For instructions on 
the final dialog box, see “Completing the Search 
Inquiry”. 
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Searching by Filing Subtype 
 

1. On the Retrieve by Filing Details first dialog box, 
select Filing Subtype in the Retrieve By list. 

 
The Criteria field displays in the dialog box. 

 

 

 
2. Under Criteria, click the required subtypes and 

click Next. 

 
The Select a Date Range dialog box displays. For 
an illustration, see “Retrieving Filings by Date”. 

 

3. Enter the date from which you want to retrieve your 
filings and click Next. 

 
The final dialog box displays. For further 
instructions on the final dialog box, see 
“Completing the Search Inquiry”. 
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7.2.5 Completing the Search Inquiry 
 

Regardless of the criteria used in your search inquiry, 
when you are done entering them click Next. The final 
wizard window displays. 

 

 

Hidden if the default 

search inquiry creation 

method is Advanced 

Inquiries 

 

Type over to modify 

the system- 

generated 

description, if 

desired 

 
 

1. On the final window, you can perform the following 
actions: 

 

• Make the inquiry your default inquiry by 
selecting the Make This My Default Refresh List 
Inquiry. 

• Change the short system-generated description 
of the inquiry in the Inquiry Name field to make 
it more meaningful to you for later use. 

 

2. When done, click Finish. 

 
The Quick Search Inquiries dialog box displays 
showing the newly created inquiry in the list of 
inquiries to be used with the Refresh List function. 
For information see “About the Quick Search 
Inquiries Dialog Box”. 
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7.3 Using the Advanced Inquiries Function 
 

To populate the list of filings displaying in the Filing 
Management window, create search inquiries and 
send them to the SEDAR server to search the filings 
database. A search inquiry consists of a combination 
of fields, operators and criteria that you define in 
SEDAR using the Advanced Inquiries or the Quick 
Search Inquiries function (for more information, see 
“About Fields, Operators and Criteria”). 

 

The Advanced Inquiries function (formerly the 
“Customize List” function) enables you to create 
customized searches for special needs; use it only if 
the Quick Search Inquiries function does not give you 
the required results. 

 

The Quick Search Inquiries function uses a wizard to 
help you easily create most of the inquiries you need 
to complete your daily tasks. Use this function for 
quick retrieval of information. For further instructions, 
see “Using the Quick Search Inquiries Function”. 

 
 

To use the quick search inquiries as default inquiries 
for the Refresh List function, you must select Quick 
Search Inquiries as the default search method in the 
User Profile and Defaults dialog box (see “Setting Up 
SEDAR”). 
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To populate your list of filings using the Advanced 
Inquiries function: 

 

1. On the Filing Management window, from the 
Options menu, select Advanced Inquiries. 

 

The Advanced Inquiries dialog box displays. 
 

 
 

 
2. Select an empty inquiry and click View. 

 

The View Filings Database Inquiry dialog box 
displays. 
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3. Click Build. 
 

The Build Filings Database Inquiry dialog box 
displays. You can now start creating your inquiry. 

 

 

 
4. In the Description field, enter additional information 

(up to 40 characters) to help you identify the 
inquiry. This field must be completed in order to 
save or submit the inquiry. 

 

5. Select a field from the List of Fields to Search on. 
For each field you select, the available operators 
display. 

 

6. Select an operator. The operator determines the 
relationship between the field you are searching on 
and a specific criterion. 
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7. Select a criterion. If you have selected the Like 
operator, type an asterisk at the end of your 
criterion if you want to include all occurrences of 
the keyword followed by another word. 

 

For more information, see “Recommended 
Operators and Criteria”. 

 

Note: Text criteria searches are not case-sensitive. 

For example, “the general management 
company” would match “The General 
Management Company.” 

 
When entering multiple words in your 
criterion, make sure you type a single space 
between them. 

 

8. Once you have selected a field, operator and 
criteria combination, click Add/Keep Adding to add 
that selection to the inquiry and continue building. 
Once a field has been added, an asterisk displays 
beside it in the List of Fields to Search on field. 

 

• To add more fields to your inquiry, repeat steps 
5 to 8. 

• To delete a criterion for a particular field and 
operator combination, click Clear Criteria. 
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9. To view your inquiry or modify an existing field, 
operator and criteria combination, click either OK, 
or Add and View. 

 
The View Filings Database Inquiry dialog box 
displays. 

 

 

 
Note: All the combinations you have selected are 

listed on the View Filings Database Inquiry 
dialog box. The AND condition is implied 
between each field in the inquiry, even if a 
field is selected many times. 
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10. Select one of the actions shown in the following 
table. 

 
Click… To… 

 
 

Change 
Operator 

Change 
Criteria 

Clear 
Inquiry 

Modify an operator in an inquiry 

Modify a criterion in an inquiry 

Delete the entire inquiry 

Build Return to the Build Filings Database Inquiry 
dialog box and continue building your 
inquiry 

 
 

Save Save the inquiry and return to the 
Advanced Inquiries dialog box 

 
Note: On the Advanced Inquiries dialog box, the 

name of the inquiry displays in the Inquiry to 
Use for the Refresh List field. 

 

 

To refresh your list, see “Refreshing 
Information on Filings”. 
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7.3.1 General Tips for Customizing Lists 
 

As you build inquiries in the Filing Management 
module, the following general tips will help you make 
your inquiry more precise and effective. 

 
Using Indexed Fields 

 

The SEDAR database contains indexed fields (fields 
for which an index exists) that enable faster retrieval of 
data. Building inquiries using these indexed fields 
helps you locate data faster by speeding up the 
processing time in SEDAR. 

 

The indexed fields are shown in the table below. 
 

Module Type Indexed Fields 
 

 

Filing 

Management 

Access Level of Document 

Age (in days) of Submission 

Age (in days) since Project last updated 

Category of Filing 

Date of Submission 

Date Project was Last Updated 

Filing Type 

Issuer/Filer Name, English 

Recipient 

SEDAR Project Number 
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When searching for filings based on an issuer’s name, 
other profile data (e.g., the jurisdiction of the issuer) 
or any type of cover page data (e.g., Initial Public 
Offering), specify whether the issuer is an Investment 
Fund or Other Issuer in the Profile Type field. By 
specifying this, you reduce the number of projects 
being retrieved and make your inquiry faster. 

 

When choosing a field that is not indexed, avoid 
including more than one criterion in the Criteria field 
(e.g., B.C., British Columbia). Adding more criteria 
reduces the volume of retrieved data but increases the 
retrieval time. 

 
Recommended Operators and Criteria 

 

The operators and criteria you select affect whether an 
index is used to find the data. Use the operators and 
tips listed in the table below to build inquiries. 

 

Operator Tips 
 

 

= •  Use the = operator instead of the >=, <=, > or < operators, 

whenever possible 

• Whenever possible, select or enter only one criterion for a 

field that is not indexed. Selecting more than one criterion 

reduces the volume of data retrieved but increases the time 

it takes to find the data 
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Operator Tips 
 

 

Like •  Do not place a wildcard character in the first position of a 

search criterion (e.g., *Issuer Name) when using this 

operator. If a character exists for the field you selected, the 

index will not list the entry 

• To reduce the number of projects or profiles being returned 

and make your inquiry faster, enter as many characters as 

you can before placing a wildcard character as the last 

character. Do not place a character after a wildcard 

• Whenever possible, select or enter only one criterion for a 

field that is not indexed. Selecting more than one criterion 

reduces the volume of data retrieved but increases the time 

it takes to find the data 

 

 

Customizing Your List Effectively 

 

As you make more filings, your filing list will get longer. 
It is recommended to customize your filing list to better 
manage your filings. 

 

The table below shows the most efficient ways to view 
certain filings and to filter out those you may not want 
to see. 



Filer User's Guide 8.054 Page 201 

Monitoring the Progress of Projects 
 

 

 
 
 

 

To search by… Use… 
 

 

A specific 

company 

For the Issuer/Filer Name, English field, use the = operator 

and type the full name of the company 

Note: If this is the only criterion in your inquiry, all filings ever 
made for that company or associated companies are 
displayed as well as the ones filed under the previous 
or new name of that company or investment fund group 

If you know either of the following, follow the procedures below 

to narrow the search and reduce the retrieval time: 

• The issuer type—For the Profile Type field, use the = 

operator and enter the issuer type (e.g., Other Issuer or 

Investment) 

• The filing type—For the Filing Type field, use the = operator 

and select the filing type(s) from the criteria list 

The date of 

submission 

 
 
 

The project 

number 

 
 
 

The company’s 

stock symbol 

For the Date of Submission field, use the >= operator and type 

in the date in the mm/dd/yy format. When the list has been 

refreshed, only these filings submitted on or after the date 

specified are listed 

For the SEDAR Project Number field, use the = operator and 

type the project number (or numbers separated by a 

semicolon). The search results are returned relatively quickly 

since you selected an indexed field 

For the stock symbol field, you can use any operator except 

Not = and Not Like. Enter a maximum of five uppercase letters 
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7.4 Customizing Your View of the Filings List 
 

On the Filing Management window, you can decide 
which columns of information to display in the list of 
submissions and arrange the positioning of the 
columns. 

 

To customize the view: 
 

1. On the Filing Management window, from the 
Options menu select Columns to Include. 

 

The Columns to Include View dialog box displays. 
 
 
 
 
 

An asterisk 

indicates a filing 

from a previous 

issuer 

Clicking Default 

resets the order 

of the columns 

displayed to the 

default setting 

 
 
 
 
 

2. Select the columns you want displayed on the 
Filing Management window and click OK. The 
column selections are saved from session to 
session. 
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Note: The Date Submitted and Time Submitted 
columns are useful to display the status of 
projects. 

 

3. Select one of the actions shown below. 

 
To… Do the following… 

 
 

Return to the Filing 

Management window 

Click OK 

 
 

Arrange the columns Click Arrange. The 
Arrange Columns dialog 
box displays. Go to step 4 

Return the columns to the 

default settings 

Click Default 

 
 

Cancel your selection Click Cancel 

 
4. Enter the number representing your intended 

position for the column name in the list. Click 
beside the name. The other columns automatically 
renumber themselves accordingly. 

 

 

 
5. After you have completed arranging the columns, 

click OK. 
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The Columns to Include in View dialog box 
displays. 

 

 

 
6. Click either: 

 

• OK—To return to the Filing Management 
window to view your new columns setting. The 
column arrangement is saved from session to 
session. 

• Default—To reset the columns to the default 
setting. 
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Showing the Condensed List 

 
If you want to see only the most recent submissions in 
a project, select Condensed List from the Options 
menu in the Filing Management window as shown 
below. 

 

 
 

Sorting Entries in a Column 

 
To sort the submissions list: 

 

1. On the Options menu, select Sort Preferences. 
(Notice, in the following example, the order of the 
project numbers.) 
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The Sort Preferences dialog box displays. 
 
 

 

 
2. Select the column for which you want to change 

the sorting order and, in the Direction column, 
select your preference (in either ascending or 
descending order). 

 
Once you have made all of your choices, click OK 
for the changes to take effect on the Filing 
Management window. Only the columns selected 
for display are sorted. 
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7.5 Refreshing Information on Filings 
 

In Filing Management, the following two functions can 
be used to refresh information relating to filings 
(i.e., fee payment status): 

 

• Refresh Project—To refresh information on up to 
10 projects. 

• Refresh List—To refresh the list of filings on the 
Filing Management windows. 

 

 
 
 

Refreshing Information on Projects 
 

You can refresh the information on up to ten projects. 
 

On the Filing Management window, select the projects 
for which you want to refresh information and click 
Refresh Project. The information is updated. 
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Refreshing the List of Filings 
 

You are able to select an inquiry from either the 
Advanced Inquiries or the Quick Search function to 
use as your Refresh List default. 

 

If you select Quick Search Inquiries as your default 
function, the default inquiry indicated on the Quick 
Search Inquiry list will be used when you select the 
Refresh List button on the Filing Management window. 

 

For more information, see “Setting Up SEDAR” 
and “Completing the Search Inquiry”. 

 

SEDAR will connect to the server, retrieve all projects 
submitted by your subscriber company matching the 
selected inquiry and send them to your computer to 
create the list of submissions on the Filing 
Management window. 

 

Alternatively, if you have selected Advanced Inquiries 
as your default Refresh List function or wish to 
execute an ad hoc inquiry using an inquiry created in 
Advanced Inquiries, follow the steps below: 

 

1. On the Advanced Inquiries dialog box, select an 
inquiry and click OK. The Filing Management 
window displays. 

 

Note: You can only refresh one list at a time. The 
inquiry selected in the Inquiry to Use for the 
Refresh List is saved from session to 
session. 
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2. Click Refresh List. SEDAR connects to the server, 
retrieves all projects submitted by your subscriber 
company matching the selected inquiry and sends 
them to your computer to create the list of 
submissions on the Filing Management window. 
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7.6 Viewing the Access Level of Documents 
 

When a document has been added to a filing, you can 
view the access level in order to find out whether the 
document is public or private and, in certain cases, the 
reason it is private. 

 

To view the access level of a document: 
 

1. On the Filing Management window, select a filing 
and select Open Submission from the File menu. 

 

The Open [Submission type] window displays, 
displaying the access level of the document within 
the filing. 
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The following table shows the private access levels 
and what action you can take, if any, to make 
documents public. 

 

Access level Explanation Action to take 

Private The file should remain Take no action 

 private  

Private – Draft The file: Take no action 

 • Contains erroneous  
 or inaccurate Note: This 

 information submission will 

 • Is submitted as a 

draft for review 

never be made 

public 

 purposes only  

Private – Virus The file contains a Disinfect or 

 virus that was not recreate the file 

 detected by the and resubmit it 

 SEDAR anti-virus  
 program  

Private – Something is wrong in Make corrections 

Incorrect the submission, for and  resubmit the 

Filing example, the filing type file 

Private – The file format is wrong Save the file in an 

Incorrect  accepted format 

Format  and resubmit it 

Private – The file will never be Take no action 

Nonpublic made public  

Private – The file will never be Take no action 

Nonpublic – made public  
Incorrect   
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When an agency changes the access level of a 

document in a specific project, the access level of the 

same document attached to another project is not 

affected. 
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7.7 Viewing the Status of Filings 
 

When a project has been submitted, you can check 
the status of a particular filing for that project with the 
principal jurisdiction or a recipient agency if no 
principal jurisdiction was selected. 

 

To view the status of a filing: 
 

1. On the Filing Management window, select a filing 
and click Refresh Project. 

 

2. When the refresh is complete, click Status. 
 

The Filing Status dialog box displays. 
 
 

 

 
 
 
 
 
 
 
 
 
 
 

A “Y” indicates that 

the filing was 

received by SEDAR 

for that agency 
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3. Click Details. 
 

The Filing Status Details dialog box displays with 
detailed status information. 

 
 
 
 
 
 
 
 
 

The date the status was set 

and agency contact 

information display here for a 

specific agency or for all 

recipient agencies, 

depending on your selection 

for the Agency detail list 

 
 

The Current General Status field displays the 
status of the filing as set by the principal jurisdiction 
and serves as an indicator of the overall status of 
the filing in the approval process if applicable. 

 

For the list of statuses and their descriptions, refer 
to Chapter 10 of the SEDAR Filer Manual. 

 
 

Certain statuses are automatically set by SEDAR 
(e.g., Filed with SEDAR) while others are set by the 
principal jurisdiction (e.g., Under Review). 
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7.8 Retrieving Formal Correspondence 
 

When a recipient agency sends formal 
correspondence (e.g., a receipt or letter of 
acceptance) you can retrieve all the attached 
documents in that or any other submission appearing 
on the listing of submissions on the Filing 
Management window. You can also select multiple 
submissions at the same time to download their 
attached documents. 

 
 

Certain market centres do not use this function. To 
find out which ones do, contact each market centre. 

 

With the implementation of Release 6.0, recipient 
agencies will always submit formal correspondence in 
PDF format. 

 

To retrieve a document: 
 

1. On the Filing Management window, select a project 
and click Refresh Project to update the submission 
list with any formal correspondence sent by the 
project’s recipient agencies. 

 

2. Select the required submission and click Retrieve. 
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The Receive Document File Destination dialog box 
displays. 

 

 

 
3. Select the settings that will be used to receive the 

selected documents from the server. 
 

• If you select the Use Default Settings, you will 
only be able to change the name of the file. 

• If you select Use User Defined Settings, you 
are able to specify the drive, directory and 
filename for the retrieved documents. 

 

4. After you have made your selection, click OK. 
SEDAR connects to the server and downloads the 
documents according to the specified settings. 

 

5. If there are multiple documents to be downloaded, 
a message displays asking you if you want to save 
all documents to their specified directories. Click 
Yes. 
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Note: If an error message displays, follow the 
instructions in the message. For more 
information, see “File Messages”. 

 

6. Once the retrieval has been completed, a 
confirmation dialog box displays. Click OK. 

 

7. Click OK to return to the Filing Management 
window. 

 
 

You can also retrieve the documents attached to a 
submission by selecting the submission from the list of 
submissions on the Filing Management window and 
clicking Open. The cover page for the submission 
opens, displaying the document type list and file 
names of the attached documents. If you select 
multiple documents in an open submission, the 
Retrieve button is still available. After clicking 
Retrieve, the retrieval process is the same as 
described in steps 1 to 7. 
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7.9 Viewing the Status of Fee Payments 
 

After a project has been submitted, you can check the 
status of the fee payments for a particular filing or for 
the entire project. The Payment Status Detail dialog 
box shows if the payment instructions you submitted to 
your financial institution have been accepted and 
followed, or if they were rejected, for example, 
because of insufficient funds. 

 

To monitor the status of fee payments: 
 

1. On the Filing Management window, select the 
required filing and click Refresh Project. 

 

2. When the refresh is complete, select Fees from the 
View menu. 
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One of the following occurs: 
 

• If fees have been submitted, the Summary of 
Filing Fees dialog box displays, showing the 
status of fee payments for the entire project. 
The dialog box also indicates whether your 
financial institution has accepted or rejected 
your payment instructions. For detailed 
information on the Summary of Filing Fees 
dialog box, see “Adding Fees”. 

 

 
 
 

• If no fees have been submitted, the Add/Modify 
dialog box displays. To add the fees, see 
“Adding Fees”. 

 
 

These fields indicate 

the status of fee 

payments as set by 

your financial institution 

(FI) 
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3. Click Payment Status Detail to view more detailed 
information. The Payment Status Detail dialog box 
displays, showing details for all fee payments 
made for the project and applicable GST and QST 
or HST. You can view: 

 

• The date and time that the payment instructions 
were submitted to SEDAR and to the financial 
institution (FI) 

• The date and time that the FI sent their answer 
to SEDAR 

• The reason the payment instructions were 
rejected, if applicable. 

 
 

GST and QST or HST 

are only charged on 

market centre filing 

fees 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

4. When you have finished viewing the status of fee 
payments for a project, click OK to return to the 
Summary of Filing Fees dialog box. 

 

5. Click Cancel to return to the Filing Management 
window. 
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Chapter 8 

Searching for Filings 
 

8.1 Overview 
 

The Search Filings module enables you to search the 
SEDAR filings database on the server for public filings, 
and to retrieve the filings that are of interest to you. 
The server sends back a report to your local database 
listing all of the filings corresponding to the search 
criteria of the inquiry. You can retrieve the documents 
attached to the filings by downloading them to your 
computer. 

 

8.1.1 Useful Definitions 

• Wildcard character—A character (in SEDAR, an 
asterisk) which represents any number or 
combination of characters, symbols and spaces 
valid for a field type, including no characters. If you 
select the Like operator in a field-operator-criterion 
combination, type an asterisk at the end of your 
criterion, to include all occurrences of the criterion 
followed by another word, for example, Like 
Somervil*. 
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• OR condition—When you use the operators Like or 
=, all information returned as a result of a search 
satisfies at least one of the alternatives in the 
multiple criteria specified in the same line of the 
inquiry. For example, in the following illustration, 
where the operator Like is used for the field 
“Auditor Name”, the OR condition is implied 
between the three criteria selected (McDougal, 
Eisen and Bradshaw). This means that the system 
will search for filings for which the auditing firm is 
McDougal or Eisen or Bradshaw. 

 

OR condition implied 

between the operators 

Like and = 

 
For a date field, the 

operators 

> =, >, <= and < can only be 

selected once 

AND condition implied 

between the operators 

Not Like and Not =, and 

between all lines of the 

inquiry 
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• AND condition—When you use the operators Not 
Like and Not =, the AND condition is implied. 
Consequently, all information returned as a result 
of a search satisfies all the alternatives in the 
multiple criteria specified in the same line of the 
inquiry for the operators Not Like and Not =, and 
between the criteria specified with the operators 
Not Like and Not in all the lines of an inquiry. For 
example, in the previous illustration, the AND 
condition is implied between the criteria (Amherst, 
Bell and Crane) for the field Distributor (principal) 
Name and the operator Not Like. This means that 
the search will not include filings for which the 
distributor is Amherst and Bell and Crane. 

 
 

The AND condition is also implied between all the 
lines of the inquiry. This means that in the example 
above, the search will include filings for which the 
Auditor Name is McDougal, Eisen or Bradshaw, 
and the Date of Formation is from December 31, 
1990 to December 31, 1995 inclusively, and the 
Distributor Name is not Amherst, Bell and Crane, 
and the SEDAR Project Number is 200 or less. 
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8.1.2 About Fields, Operators and Criteria 
 

A search inquiry consists of a combination of fields, 
operators and criteria that you define in SEDAR. The 
following table shows the different types of fields 
possible to search on in SEDAR and the rules that 
apply to each type when building search inquiries. 

 
 

Field 

type 

 

Field 

example 

 
Operators 

to use 
Method of criteria entry 

 
 

Text General 

Partner 

Name, 

English 

Like,  

Not Like, 

=, Not =, 

>=, <=, 

>, < 

• Free-form text entry up to 40 characters 

• Space-sensitive; type a single space between 

words to get best results; e.g., if you insert 

two spaces between Bell_ _Canada and the 

entry was created with one space (for 

example, Bell_Canada), the search is not 

successful 

• Not case-sensitive. For example, the general 

management company would match The 

General Management Company 

• Operators can be selected up to 10 times for 

an inquiry 

• Multiple criteria permitted 

• Use wildcard character (*) for the Like 

operator 

• For =, not =, like and not like, separate each 

criterion by a semicolon 

• OR condition implied between operators Like 

and = 

• AND condition implied between operators Not 

Like and Not = 

Age Age (in 

days) of 

Submission 

<= •  Digits and date separators up to a maximum 

value 

• No decimals permitted 

• No multiple criteria permitted 
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Field Field Operators 

 

 

type example to use 
Method of criteria entry 

 

Date Date of 

Submission 

=, Not =, 

<=, >=, 

• Digits and date separators 

(for example, mm/dd/yyyy) 

  <, > • Operators can be selected up to 10 times for 

an inquiry 

   • No multiple criteria permitted. You cannot 

define a search to include all filings with two 

date-range periods using the same operator 

more than once. For example, to do a search 

using a Date of Submission between Dec. 31, 

1990 and Dec 31, 1992 and between Dec. 31, 

1994 and Dec 31, 1995, you must use all 

operators (>=, >, <= and <) once 

   
Consequently:, you cannot use: 

> 12/31/1990 and < 12/31/1992 

>12/31/1994 and <12/31/1995 

   
But you can use: 

> 12/31/1990 and < 12/31/1992 

>=12/31/1994 and <= 12/31/1995 

Amount Aggregate 

Gross 

=, Not =, 

<=, >=, 

• You may be requested to select a criterion 

from the list 

Proceeds <, > • If you do not select a criterion from a list, use 

the format: ######.######## (where # is a 

digit from 0 to 9) 

At least one digit must be entered; if the 

decimal is omitted, it is assumed to be at the 

end 

• Operators can be selected up to 10 times for 

an inquiry 

Option 

Buttons 

RRSP 

Eligibility 

= Single option to be selected (Yes or No) 
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Field Field Operators 

 

 

type example to use 
Method of criteria entry 

 
 

List 

field 

Manner of 

Formation 

=, Not = •  You may select a criterion from the list 

• Multiple criteria permitted 

• Some selections may cause other selections 

to become deselected (e.g., by selecting “All” 

or “Not applicable”) 
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8.2 Searching Effectively in SEDAR 
 

The following search tips help reduce your waiting 
time when searching in the SEDAR databases by 
making your inquiry more precise and effective. 

 

8.2.1 Using Indexed Fields 
 

The SEDAR database contains indexed fields (fields 
for which an index exists) that enable faster retrieval of 
data. The database is much like a book. If you are 
looking for a topic, you turn to the book’s index where 
you see the page numbers that relate to that topic and 
you go directly to those pages. If you do not find the 
topic in the index, you may need to flip through every 
page of the book to find the topic. Clearly, it takes 
longer to go through each page of the book than it 
does to use the index. 

 

Similarly, building inquiries using these indexed fields 
helps you locate data faster by speeding up the 
processing time in SEDAR. You build inquiries from 
the Build Filings Database Inquiry dialog box. 
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The indexed fields are shown in the table below. 

 
Module type Indexed fields 

 
 

Search Filings Access Level of Document 

Age (in days) of Submission 

Age (in days) since Project last updated 

Category of Filing 

Date of Submission 

Date Project was Last Updated 

Filing Type 

Issuer/Filer Name, English 

Recipient 

SEDAR Project Number 
 
 

When searching for filings based on an issuer’s name, 
other profile data (e.g., the jurisdiction of the issuer) 
or any type of cover page data (for example, 
Financial Period Ended), specify whether the issuer is 
an Investment Fund or Other Issuer in the Profile Type 
field. By specifying this, you reduce the number of 
projects being retrieved and make your inquiry faster. 

 

When choosing a non-indexed field that enables the 
entry of free-form text in the criteria field, avoid 
entering more than one criterion in the Criteria field 
(e.g., B.C., British Columbia). Adding more criteria 
reduces the volume of retrieved data but increases the 
retrieval time. 
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8.2.2 Using Operators and Criteria 

Effectively 

The operators and criteria you select affect whether an 
index is used to find the data. Use the operators and 
tips listed in the table below to build inquiries. 

 

Operator Tips 
 

 

= •  Use the = operator instead of the >=, <=, > or < 

operators, whenever possible 

• Select or enter only one criterion for a field that is 

not indexed (see the table in “Using Indexed 

Fields”). This reduces the volume of data 

retrieved but increases the time it takes to find 

the data 
 

 

Like •  Do not place a wildcard character in the first 

position of a search criteria (e.g., *Issuer Name) 

when using this operator. If a character exists for 

the field you selected, the index will not list the 

entry 

• To reduce the number of projects or profiles being 

returned and make your inquiry faster, enter as 

many characters as you can before placing a 

wildcard character as the last character. Do not 

place a character after a wildcard 

• Select only one criterion for a field that is not 

indexed (see the table in “Using Indexed Fields”). 

This reduces the volume of data retrieved but 

increases the time it takes to find the data 
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8.2.3 Optimizing Your Search Inquiries 
 

The table below shows the most efficient ways to 
retrieve filings. 

 

To search 

by… Use… 
 

 

A specific 

company 

 
 
 
 
 
 
 
 
 
 
 
 

One or more 

words that 

the filer’s 

name starts 

with 

For the Issuer/Filer Name, English field, use the = operator 

and type the full name of the company 

If you use only this criterion in your inquiry, all filings ever made 

for that company are retrieved as well as the ones filed under 

the previous or new name of that company or investment fund 

group 

To narrow the search and reduce the retrieval time specify: 

• The issuer type—For the Profile Type field, use the = 

operator and enter the issuer type (for example, Other 

Issuer or Investment Fund Group) 

• The filing type—For the Filing Type field, use the = operator 

and select the filing type(s) from the criteria list 

For the Issuer/Filer Name, English field, use the Like operator, 

type in as many of the words in the company name as 
possible, and enter an asterisk (*) as the last character 

If you use only this criterion in your inquiry, all filings ever made 

for that company under their current and other names are 

retrieved, which can result in an exhaustive but longer search 

To narrow the search and reduce the retrieval time specify: 

• The issuer type—For the Profile Type field, use the = 

operator and enter the issuer type (e.g., Other Issuer or 

Investment Fund Group) 

• The filing type—For the Filing Type field, use the = operator 

and select the filing type(s) from the criteria list 
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To search 

by… Use… 
 

 

A specific 

date 

 
 
 
 
 

The age (in 

days) of the 

submission 

 
 

 
The project 

number 

 
 
 

The 

company’s 

stock symbol 

For the Date of Submission field, use the = operator and enter 

the date in the mm/dd/yy format. All filings made on the 

specified date are retrieved 

If you also know the filing type, in the Filing Type field, use the 

= operator and select the filing type from the criteria list 

Note:    You can select more than one entry 

For the Age (in days) of Submission field, use the <= operator 

and type the number of days (for example, 30). The filings 

which were submitted in the specified time period are retrieved 

Note: You cannot use this field and the Date of Submission 
field in the same inquiry 

For the SEDAR Project Number field, use the = operator and 

enter the project number (or numbers separated by a 

semicolon). The search results are returned relatively quickly 

since you selected an indexed field 

For the stock symbol field, you can use any operator except 

Not = and Not Like. Enter a maximum of five uppercase letters 

(A–Z) 

 
For more information on building search inquiries, see 
“Building a Search Inquiry”. 
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8.3 Building a Search Inquiry 
 

To build a search inquiry you specify fields, operators 
and criteria. 

 

1. On the SEDAR main window, select Search 
Filings. 

 

The Search Filings window displays. This is where 
the inquiries you create and submit are listed. This 
list is empty until you have saved or submitted the 
first inquiry. 

 

2. Click New Inquiry. 

 
The Build Filings Database Inquiry dialog box 
displays. 

 

 

 
3. In the Inquiry Name field, enter a name for your 

inquiry (up to eight characters). 
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4. Press TAB. In the Description field, enter additional 
information (up to 40 characters) to help you 
identify the inquiry. Both these fields must be 
completed in order to save or submit the inquiry. 

 

5. Select a field from the List of Fields to Search On. 
For each field you select, the available operators 
display. 

 

6. Select an operator. The operator determines the 
relationship between the field you are searching on 
and a specific criterion. 

 

7. Type or select a criterion. For information on 
criteria rules, see “About Fields, Operators and 
Criteria”. 

 

8. Once you have selected a field, operator and 
criteria combination, click Add/Keep Adding to add 
that selection to the inquiry and continue building. 
When a field has been selected, an asterisk 
displays beside it in the List of Fields to Search On. 

 
To delete a criterion for a particular field and 
operator combination, select the criterion and click 
Clear Criteria if you have not yet added it to the 
inquiry. 

 

9. When you have finished defining your inquiry, click 
Add and View. 
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The View Filings Database Inquiry dialog box 
displays showing the combination you have 
chosen. 

 

 

 
10. Select one of the following actions shown below. 

 

To… Do the following… 
 

 

Continue building your 

inquiry 

Click Build 

Delete the entire 

inquiry 

Delete a combination 

in your inquiry 

Click Clear Inquiry 
 

Select a field and click Delete 

Selection 
 

 

Modify a combination Select it from the list and click 

either Change Operator or 

Change Criteria 
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11. When done, click either: 
 

• Save—To save your inquiry in your database 
before submitting it to SEDAR. The Search 
Filings window displays. 

• Submit—To submit the inquiry now. 
 

Note: It is recommended that you first save an 
inquiry to your database before submitting it. 
See “Submitting an Inquiry”. 
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8.4 Submitting an Inquiry 
 

1. If you are not already in the Search Filings module, 
open it from the SEDAR main window. 

 

The Search Filings window displays. 
 

 

 
2. Select an inquiry and click Submit Inquiry. 

 

3. When prompted by SEDAR, enter a report name or 
select one from the list in the window. The report 
name is automatically assigned the first time an 
inquiry is submitted. Click OK. 

 

The inquiry is sent to the SEDAR server. The 
search is done in the Search Filings database for all 
filings matching your search criteria that are public 
or that are private but were sent by your company 
or filing agent, or for which you are a secondary 
filer. 
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After some time, depending on the complexity of 
the search, SEDAR downloads a report to your 
computer and the Search Filings window displays. 

 

 

 
If you use Issuer/Filer Name or Profile Number as 
search criteria, projects submitted by previous 
issuers are included in your search results and are 
indicated with an asterisk beside the Issuer/Filer 
Name. 

 

4. Select the inquiry and click Open Report. The 
Filings Reports dialog box displays with reports 
listing the filings found and sent by SEDAR for 
search inquiries. 
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5. Select a report and click Open Report. 
 

The Filing Database Report window displays. 
 
 
 

 
If an asterisk 

appears in this 

column, it 

indicates that 

the filing is 

from a 

previous filer 

 
 
 
 
 
 
 

 

6. Select Display Documents List from the Options 
menu to view the names of all of the individual 
documents sent as part of that report. 

 

Note: Other filings that were filed with profiles 
matching the inquiry will be returned, as well 
as filings using profiles that are related to 
matching profiles through a previous profile 
relationship. This applies if the Issuer/Filer 
Name or Profile Number fields are selected 
in the inquiry. 

 

7. Select a document from the list and click Retrieve. 
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8. The Receive Document File Destination window 
displays and you are prompted to specify where 
you want to store the retrieved documents. 

 
Select either Default Settings 
(C:\SEDAR\Filings\project number\submission 
number\file name) or User Defined Settings* and 
click OK. 

 
*If you select User Defined Settings, you are 
prompted to enter the new path for storing the 
documents. When done, click OK. 

 

 

9. Once the retrieval process has been completed, a 
confirmation dialog box displays. Click OK. 

 
 

The report also contains all confidential documents 
that you are authorized to view (e.g., a filing 
submitted by you or another user belonging to your 
organization). For more information on a filing or 
related documents, select the filing from the list on 
the Filing Database Report and select the 
appropriate command. 
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8.5 Modifying a Search Inquiry 
 

The View Filings Database Inquiry dialog box is used 
to view or modify inquiries. Each field, operator and 
criteria combination for the inquiry is displayed. 

 
You can delete a selection or change an operator or a 
criterion by selecting it and choosing the 
corresponding command button below the list for that 
selection. 

 
Inquiries can also be modified from the Build Filings 
Database Inquiry dialog box. You can switch between 
the build and view modes when building or modifying 
an inquiry. You can submit an inquiry to the server 
from the view mode only. 

 
Updating a Search Inquiry 

 
You can change an existing inquiry that was 
previously saved or submitted. You can open and 
modify the inquiry as described above. When you 
submit an updated inquiry that was previously 
submitted, SEDAR prompts you to enter a new report 
name for the inquiry. 

 

Note: If you delete an inquiry that was previously 
submitted, all associated reports and their lists 
of filings are also deleted. 
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Chapter 9 

Exchanging Mail 
 

SEDAR provides all users with a means of informal 
communications. This form of communication is 
separate from the formal process of electronic filing or 
formal correspondence. The table below lists the 
functions available in the Mail Functions module. 

 

Click... To do this... 
 

 

 
Create and send e-mail to other SEDAR 

users 

 
 

Open and read e-mail sent by SEDAR 

users 

 
Create an address book for storing the 

names, user IDs and other address 

information for other SEDAR users 
 

        Send files to SEDAR users 

Download files sent to SEDAR users 
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9.1 Creating Mail 
 

The New Note function enables you to send informal 
correspondence to other SEDAR users. This function 
can only be used to create and send notes. When you 
use it, the messages you create and send are 
retrieved and read using the Review Mail function. 

 

To create and send a note: 
 

1. On the Mail Functions window, click New Note. 
 

The SEDAR – Note Editor-Note window displays. 
 
 
 
 

 
Mail 

 
 
 
 
 
 
 
 
 
 

 
2. Enter the name of the person you want to send the 

note to in the To field and the subject in the Subject 
field, then enter the body of your note into the main 
edit note window or paste the text from another file. 

 

3. Click Mail on the toolbar. 
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The Mail Note To dialog box displays. 
 

 

 
4. Do one of the following: 

 

• If you know the user ID, type it in the 
UserID@Node field. Go to step 9. 

• If you do not know the user ID and you have 
created address books, click Address Book. 
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The SEDAR – Address Book window displays. Go 
to step 5. 

 

 

 
Note: To create an address book, see “Using 

Address Books”. 
 

5. On the File menu, select the appropriate address 
book. 
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The SEDAR – Address Book—AddrBK1 (or 2, 3, 
and so on) dialog box displays. Click OK. 

 

 

 
6. Double-click the name of the appropriate user. 

The Add/Update Entry dialog box displays. 

 
 
 
 
 
 
 
 
 
 
 
 

7. Click the Selected for Mailing field (bottom right of 
the window), then click OK. The SEDAR – Address 
Book—AddrBK1.ADD window displays with an 
envelope beside the user’s name. 
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8. Select Add IDs to Note Address List from the File 
menu. Click Exit. The Mail Note To dialog box 
displays showing the user ID of the selected user 
in the Target Destinations field. 

 

9. Select the recipient user ID and select To (primary 
recipient), CC (carbon copy) or BCC (blind carbon 
copy). For more information on using address 
books, see “Using Address Books”. 

 

10. Click one of the following: 
 

• Mail Immediately—To send the note right away. 
The note is sent to SEDAR and you receive a 
confirmation message. 

• Queue to Mail—To send the note later. The 
note is held for mailing at a later time using the 
Review Mail module, and you receive a 
confirmation message that the note has been 
queued. 
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9.2 Reviewing Mail 
 

The Review Mail function enables you to open and 
read any notes sent to you by other SEDAR users. 
You can also access the other SEDAR Mail functions 
from Review Mail. 

 

To review mail sent to you: 
 

1. On the Mail Functions window, click Review Mail. 

The Review Mail window displays. 

 
 

2. Click Get New Mail on the toolbar. SEDAR 
connects to the server and downloads any mail 
sent to your inbasket. SEDAR prompts you with a 
confirmation message as to whether or not any 
new mail has been received. 

 
Click Get New Mail to 

connect to SEDAR and 

download any new mail  
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3. To open your inbasket, from the View menu select 
View Inbasket. A list of all notes sent to you are 
displayed. Notes appearing in red have not been 
read yet. To read the contents of a particular note, 
double-click that note. The Contents of a Note 
dialog box displays. 

 

 
 

4. After reading the note, select any of the actions 
shown below. 

 
Click... To do this... 

 
 

OK Save the note in your inbasket and 

return to your inbasket 
 

Delete Delete the note from your inbasket 
 

 

File Save the note as a file on your 

computer 
 

Forward Forward a copy of the note to another 

SEDAR user ID 
 

Reply Answer the note by composing a new 

note using the New Note function 
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Your outbasket lists all notes you have composed and 
mailed. It can be opened by choosing View Out-basket 
from the View menu. The command buttons at the 
bottom of Contents of a Note dialog box are the same 
as those for your inbasket. 

 

With the Review Mail function, you can also send any 
notes saved or queued to mail. 
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9.3 Using Address Books 
 

The Address Book function enables you to create and 
store contact mailing information and mailing lists. 
Each window in Address Book stores an address list. 
You can link address lists. 

 

Click... To... 
 

 

Create an address book 
 
 

Open an address book. SEDAR Address Book displays 

     the Open dialog box in which you can open the desired file 

Save the active address book or template with its current 

     name. If you have not named the address book, SEDAR 
Address Book displays the Save As dialog box 

Add a person to the mailing list for that address book. An 

envelope icon displays beside entries selected for mailing 
 

Link this address book with another 
 

 
Modify or edit an entry in your address book (e.g., a 

person’s address, phone number) 

 

     Erase an entry from your address book 

Find an entry in the address book 

 

     Print the active address book 

Display instructions on how to use help. (To access help 

on the Address Book function, press F1) 



Filer User's Guide 8.054 Page 251 

Exchanging Mail 
 

 

s  

o  

 
 

 

To create an address book: 
 

1. On the Mail Functions window, click Address 
Book. 

 

The SEDAR – Address Book window displays. 
 

2. Click New on the toolbar. 
 

The dialog box for ADDR.BK1 (BK2, or BK3, and so 
on, depending on the number of address books you 
have created) displays. 

 

 
Click New to 

create an addres 

book 

 
Click Add Person 

to add a person t 

the address book 

 
 
 
 
 
 
 
 
 

 

3. To add a person to the address book, click Add 
Person on the toolbar. 



Filer User's Guide 8.054 Page 252 

Exchanging Mail 
 

 

 
 
 
 
 

 

The Add/Update Entry dialog box displays. 
 

 

 
4. Complete the First Name, Last Name and User ID 

fields, which are mandatory, as well as any other 
fields desired. Click OK. 

 

The SEDAR – Address Book window displays 
showing the name of the person you just added. 
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5. Click one of the following buttons on the toolbar: 
 

• Save—To save your entry and remain in the 
SEDAR – Address Book window you are in. 

• Close—To save your entry and open another 
SEDAR – Address Book window. From that 
window you can exit the Address Book function 
or create a new address book. 

• Edit Entry—To modify a person’s address, 
phone number, etc. 

• Delete Entry—To erase an entry from your 
address book. 

 

Or, select either of the following options from the 
Edit menu: 

 

• Select All for Mailing—To add entries to the 
mailing list for that address book. An envelope 
displays beside entries selected for mailing. 

• Deselect All for Mailing—To remove entries 
from the mailing list for that address book. 
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Searching for an Address 
 

To find an address in a particular address book: 
 

1. Click Address Book on the Mail Functions window. 
The SEDAR – Address Book window displays. 

 

2. Click Open on the toolbar. 

The Open dialog box displays. 

 
 
 
 
 
 
 
 
 
 
 

 
3. Select the address book you want to search in and 

click OK. 
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The desired address book displays. 
 
 
 

Click Find to find 

an entry in the 

address book 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Click Find on the toolbar. 
 

The Find Entry dialog box displays. 
 

 

 
5. Enter the last name of the entry you want to locate 

in the address book and click OK. If the entry is in 
the address book, it is highlighted in the list in the 
SEDAR – Address Book window. 
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Linking Address Books 
 

You can link up to 10 address books so that you have 
separate address lists within an address book. 

 

To link address books: 
 

1. On a SEDAR – Address Book window 
(ADDR.BK1, 2 or 3, and so on), select Link 
Another Address Book from the Edit menu. 

 

The Link Address Book dialog box displays. 
 

 
 

2. In the Name field, enter the title for the address list 
that will be added to this address book. 
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3. Enter the file name for the address list you want to 
attach to the host address book by doing one of the 
following: 

 

• If you know the file name and path, type it in the 
File Name field. Go to step 5. 

• If you do not know the file name and path, click 
Browse. The File Open dialog box displays. Go 
to step 4. 

 

4. Select the file name from the appropriate directory 
and click OK. The Link Address Book dialog box 
redisplays with the file name and path. 

 

5. Click Selected for Mailing to have this address list 
included in the mailing list and click OK. The 
address list is attached to the other address book 
and displays in its listing. 
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9.4 Sending Files 
 

The Send Files function enables you to send files to 
yourself or other SEDAR users using your SEDAR 
workspace, outside of the formal filing process. Each 
SEDAR user ID is assigned a “personal” workspace 
on the SEDAR server which may be used as a storage 
space for exchanging files with other SEDAR users. 

 

To send a file: 
 

1. Click Send Files on the Mail Functions window. 

The SEDAR - Send Files dialog box displays. 

 
 
 
 
 
 
 

2. To attach a file to send, do either of the following: 
 

• Enter the directory, the drive where the file is 
stored and the file name. Go to step 5. 

• Click Browse. 
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The Browse dialog box displays. Go to step 3. 
 

 

 

 

3. Select the directory, the drive and the file you want 
to send. 

 

Note: If you attempt to send a file which contains 
annotations, such as attached files or 
embedded objects, the following message 
displays: 

 
“The file cannot contain annotations 
(attached files or embedded objects). Please 
remove them and resave the file.” 

 
Follow the instructions in this message. For 
more information, see “File Messages”. 

 

4. Click OK. 
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The SEDAR – Send Files window re-opens with the 
file name you entered. 

 

 

 
5. Enter the user ID of the recipient. You can also 

enter a comment to attach to the file in the 
Comment field. Click Send. 

 

• The SEDAR File Transfer dialog box displays, 
indicating the size (in bytes) of the file being 
transferred. 

 
If you want to stop the transmission once it has 
started, click Abort on the SEDAR File Transfer 
dialog box before the transmission is 
completed. 

 
Once the file has been submitted to the server, 
a confirmation dialog box displays. Click OK to 
return to the SEDAR – Send Files window. Go 
to step 6. 

• If a message displays, follow the instructions in 
the message. For more information, see “File 
Messages”. 

 

6. Select Exit from the File menu to return to the Mail 
Functions window. 
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9.5 Retrieving Files 
 

The Receive Files function enables you to retrieve files 
residing on your SEDAR workspace and perform other 
tasks with these files. 

 
 

Ensure that you have logged in with the user ID 
corresponding to the workspace from which you want 
to retrieve files. 

 

To retrieve files: 
 

1. Click Receive Files on the Mail Functions window. 
The SEDAR – Receive Files window displays 
listing the files sent to your user ID and currently 
residing on your SEDAR workspace. 

 

2. To make sure that you are looking at the most 
recent list from the SEDAR server, click Refresh. 

 

3. When the list has been refreshed, select a file from 
the listing. After you select a file, the command 
buttons at the bottom of the window become 
available. 
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4. Select one of the actions in the following table. 

 
Click... To... 

 
 

Retrieve Download a file to your computer. Files 

retrieved from your SEDAR workspace 

are sent to your default directory (usually, 

C:/SEDAR/Download/file name) and are 

deleted from the workspace 
 

Forward Send a copy of a file to another SEDAR 

user. After clicking Forward, you enter 

the recipient’s user ID in the Forward 

Files dialog box. When the file has been 

forwarded, the file is still listed on SEDAR 

– Receive Files window, but it is shaded. 

You must select it if you want to do 

something else with it 
 

Delete Delete a file from your workspace 
 

 

Refresh See if any new files have been sent to 

your workspace while the SEDAR – 

Receive Files window is open 

 
5. Select Exit from the File menu to return to the Mail 

Functions window. 
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Chapter 10 

General Information 
 

10.1 Changing Your Password 

 
To change your password: 

 

1. Open the User Profile and Defaults module from 
the SEDAR main window and click User Defaults. 

 

The User Defaults dialog box displays. 
 

 

 
2. Under Categories, click Logon Info. The Set Logon 

Information dialog box displays. 
 

3. Click Change Password on Host. 
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The Change Password dialog box displays. 
 

 

 
4. Enter the user ID for the password that you want to 

change. 
 

Note: You can change the password for the default 
user ID (the user ID you accessed this dialog 
box with) or any other user ID sharing the 
same account. 

 

5. Enter the current password in the Old Password 
field, then press TAB to move to the next field. 

 

6. Enter the new password (six to eight characters, in 
lowercase) in the New Password field, then press 
TAB to move to the next field. 

 

Note: If you receive the message “The last 
character (x) is invalid. Select another one, 
see “Common Problems”. 

 

7. Retype the new password in the Retype New 
Password field (the field is case-sensitive, so be 
sure to retype the password exactly as you typed it 
the first time), then click OK. 
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8. Click OK to change the password. The User 
Defaults dialog box displays informing you that the 
change was successful. 

 
9. Click OK. The User Profile and Defaults window 

displays. 
 

10. Click User Information. The User Information dialog 
box displays. Select Submit 

 

Note: To change the password for another user ID, 
repeat the previous steps. 

 

11. Click OK. The User Profile and Defaults window 
displays. 

 

12. Select Exit to return to the SEDAR main window. 
 
 

When the password changes are complete, give the 
new passwords to your agency Access Coordinator 
(or whoever your agency determines will manage 
passwords), in case you forget them. 
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10.2 Updating SEDAR Code 
 

SEDAR-related software updates can be distributed to 
all users from the SEDAR server via the Code Update 
function. There are two ways to initiate code updates: 

 

• Before opening SEDAR, by choosing Receive 
Items from SEDAR Server in the File menu on the 
SEDAR main window. See “Initiating a Code 
Update before Opening SEDAR”. 

• After opening SEDAR, when trying to access the 
SEDAR server. See “Initiating a Code Update after 
Opening SEDAR”. 

 

10.2.1 Initiating a Code Update before 

Opening SEDAR 

1. On the SEDAR main window, from the File menu 
select Receive Items from SEDAR Server. 

 

 



Filer User's Guide 8.054 Page 267 

General Information 
 

 

 
 

 

Once a connection to the server has been made, a 
dialog box displays with the message “Items 
received successfully. Please close all SEDAR 
windows and select Code Update to update the 
SEDAR application.” The download time varies 
depending on the size of the files transferred to 
your computer, and the type and speed of your 
connection. 

 

2. Close the SEDAR main window. 
 

3. From the Start menu, point to Programs, then 
SEDAR, and select Code Update to activate the 
code update. A confirmation dialog box displays. 

 

4. Click OK to close the dialog box. 
 

5. After the code update has been completed, reopen 
SEDAR. 

 

 
If you have any problems with a code update, call the 
CSA Service Desk at 1-800-219-5381. 
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10.2.2 Initiating a Code Update after 

Opening SEDAR 

1. Open the module you want to work in. SEDAR 
automatically detects that a code update is 
required when you try to access the server. 

 
Once the code update has been downloaded, a 
dialog box displays with the message “Items 
received successfully. Please close all SEDAR 
windows and select Code Update to update the 
SEDAR application.” 

 

2. Exit the module to return to the SEDAR main 
window. 

 

3. Close the SEDAR main window. 
 

4. From the Start menu, point to Programs, then 
SEDAR, and click Code Update to activate the 
code update. A confirmation dialog box displays. 

 

5. Click OK to close the dialog box. 
 

6. After the code update has been completed, reopen 
SEDAR. 

 

 
If you have any problems with a code update, call the 
CSA Service Desk at 1-800-219-5381. 
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10.3 Obtaining Customer Assistance 
 

The Customer Assistance dialog box displays the 
phone number to call for technical support for using 
SEDAR or accessing the network. 

 

To access the Customer Assistance dialog box: 
 

1. On the SEDAR main window, click Customer 
Assistance. 

 

The Customer Assistance dialog box displays. 
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2. If the on-screen help, user manual and applicable 
rules pertaining to the filing of securities documents 
do not answer your questions, you have the 
following options: 

 

• For questions about a particular filing (e.g., 
about rules, status, fees), click Directory to 
consult a telephone directory of each agency. 
You can call the applicable agency if you have 
any questions. 

• For questions about technical problems related 
to the SEDAR environment (for example, filer 
software or connectivity), call the CSA Service 
Desk at 1-800-219-5381. 
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10.4 Obtaining System Information 
 

You can obtain hardware and software information 
about your computer using the System Information 
module. This information can help you customize your 
environment, and identify and solve problems. 

 

To access the System Information window: 
 

1. On the SEDAR main window, click System 
Information. 

 

The System Information window displays. 
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2. Click the desired tab name to view the contents of 
the tab. 

 

• Windows—For information about your Microsoft 
Windows environment. 

• System—For information about the system that 
you are currently using. 

• Environment—For information about your 

system environment. 

• File Versions—For information on the file name, 
path and version number. 

 

On the Information menu, you can also select: 
 

• Print—To print the contents of the information 
window. 

• Exit—To return to the SEDAR main window. 
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Chapter 11 

Troubleshooting 
 

11.1 Troubleshooting Tips 
 

In an effort to offer you better, faster service, the 
CSA Service Desk has documented the most 
common problems and error messages you may 
encounter while using SEDAR and has provided you 
with possible solutions. 

 

If a problem occurs or an error message displays while 
you are using SEDAR, please try the solutions listed in 
this chapter before calling the CSA Service Desk. If 
the problem persists, call the CSA Service Desk at 1- 
800-219-5381. 

 

The documented topics are grouped in the following 
two categories: 

 

• Common Problems 

• File Messages. 
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11.2 Common Problems 
 

Below are some documented problems found in this 
chapter. 

 
Problem/Error Message  

 
 

You cannot connect to the SEDAR server  

You submitted wrong filing information  

You cannot access SEDAR Help  

You get a yellow triangle with an exclamation 

mark inside 

 

 
 

Error 18:bad login/password combination  

Either an error has occurred on the server or you 

are not authorized to access the server 

 

 
 

Error type 68: device unavailable  

An error occurred during the code update. Return 

code=2 

 

The last character (x) is invalid. Select another 

one. 
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You cannot connect to the SEDAR server 

 

If your 

connection 

type is... Do this... 
 

 

Standard 

Internet 

(high-speed 

or dial) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Site-to-site 

Internet VPN 

• Ensure that your workstation is connected 

to the internet. 

• Ensure that your workstation is not in the 

subnet of 172.17.32.0. 

• Confirm that your workstation has the 

SEDAR Internet Connectivity Engine 

installed or is connected to a SEDAR 

site-to-site Internet VPN. 

• Verify that your workstation does not have 

any other VPN client software installed, 

i.e., software other than the SEDAR Internet 

Connectivity Engine (Checkpoint 

SecureClient software version 54.1.0.2) 

which was provided with the Release 8.0 

installation program. 

• If a personal or corporate firewall is installed 

on your workstation, then ensure that it is 

configured so that IPSec and IKE ports are 

not blocked. 

• If Internet gateways (such as Netgear, 

Linksys, or D-Link) are used, please make 

sure that IPSec and IKE ports are allowed. 

Contact the CSA Service Desk at 1-800-219- 

5381 for assistance. 
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You submitted wrong filing information 

 

 

Once a filing has been submitted, it cannot be deleted 
from the server. If you have included incorrect or 
incomplete information, you must correct it by filing 
another submission for that project. 

 
If you 

submitted... Do this... 
 

 

A wrong 

profile 

 
 
 

A wrong cover 

page or 

attached file 

You can update the profile to include the 

correct information. For instructions on 

updating profiles, see “Updating a Profile”  

 

It is your responsibility to contact the 

appropriate agency. You may be asked to 

submit a request for withdrawal of that filing 

and to submit a new filing in its place or to file 

another submission using the Add to a Filing 

feature in Filing Management. For 

instructions, see “Adding Documents and 

Formal Correspondence” or “Modifying 

Cover Pages”  

 

 
You cannot access SEDAR Help 

 

If you cannot access Help when you are working with 
a SEDAR module, it may be because you have more 
windows open than can be supported by Windows. 

 

To access SEDAR Help, try either: 
 

• Closing other applications and accessing Help 
again 

• Closing the SEDAR main window and choosing 
SEDAR Help from the SEDAR group. 
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You get a yellow triangle with an exclamation mark 

inside 

 

Your computer has a memory management problem. 
 

1. Close all applications and restart your computer. 
 

2. Reopen SEDAR and resume work. 
 
 

Error 18:bad login/password combination 

 

The SEDAR version installed on your computer is not 
the current version. 

 

Install, or have someone install, the most current 
version of SEDAR on your computer and retrieve all 
code updates from the SEDAR server. For information 
on retrieving code updates, see “General 
Information”. 

 
 

Either an error has occurred on the server or you are 

not authorized to access the server 

 

The password or user ID used to access the SEDAR 
system has been entered incorrectly. 

 

1. Open the User Profile and Defaults module from 
the SEDAR main window and click User Defaults. 
The User Defaults dialog box displays. 

 

2. Click Logon Info. The Set Logon Information dialog 
box displays. 
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3. If the user ID appearing in the User ID field is 
correct, retype your password in the Default 
Password field. Type the password exactly as you 
usually enter it; this field is case-sensitive. 

 
If the user ID appearing in the User ID field is 
incorrect, enter the appropriate user ID and, in the 
Default Password field, enter the corresponding 
password. 

 

4. Click OK. The User Profile and Defaults window 
displays. 

 

5. Return to the SEDAR main window and resume 
working. 

 
 

Error type 68: device unavailable 

 

The default directory selected in the User Default is 
not accessible to your system. Change the default 
directory to a more easily accessible one, for example, 
a directory on your local drive. 

 

To change your default directory, do the following: 
 

1. Open the User Profile and Defaults module from 
the SEDAR main window and click User Defaults. 
The User Defaults dialog box displays. 

 

2. Click Default Directory. The Set Default Word 

Processing Files Directory dialog box displays. 
 

3. Select the drive and the directory and click OK. 
The User Profile and Defaults window displays. 
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4. Return to the SEDAR main window and resume 
working. 

 
 

An error occurred during the code update. Return 

code=2 

 

You get this message if SEDAR is open while you are 
running the code update program. 

 

To remedy the situation, close SEDAR and try running 
the code update again. For information on activating 
code updates, see “General Information”. 

 
 

The last character (x) is invalid. Select another one. 

 

This message displays if you try to assign an invalid 
character as the last character in your SEDAR 
password. 

 

The length of the password determines which 
characters are invalid, as shown in the table below. 

 

If your password is... The last character cannot be... 
 

 

six characters long 4, 5, 6, 7, 8, or K 
 

 

seven characters long + 
 

 

eight characters long é, ê, ë, ì, or í 
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11.3 File Messages 
 

This section is intended to help you with certain error 
messages you may encounter when using SEDAR. 
Below are some common error messages found in this 
chapter. 

 

 
Problem/Error Message  

 
 

An error message of the 3000 series (Error  

3021,Error 3040 and so on) displays 

 

The file extension is not one of the supported file 

extensions. Please select another file or rename 

the file 

The file has already been assigned to a document 

in the list. Please select a different file 

An error occurred while sending a submission for 

project <number>… 

Warning – A file by the name specified already 

exists on your PC and will be replaced by the file 

being downloaded. Do you want this file replaced? 

C:\SEDAR\directory\file name 

The stock symbol is identical to that of another 

profile in SEDAR. You cannot create this 

profile. Review existing profile 

 
 
 
 

 
 
 
 
 

The issuer has ceased reporting. The profile 

cannot be used to create a filing unless the profile 

is updated 

 

 
 

A virus has been found  

 
 
 

An error message of the 3000 series (Error 3021, Error 

3040 and so on) displays 
  

The database you are working in is corrupted. 
 

1. Close the module. 
 

2. On the SEDAR main window, select Database 
Maintenance from the File menu. The Database 
Maintenance dialog box displays. 
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3. Close the module. 
 

4. On the SEDAR main window, select Database 
Maintenance from the File menu. The Database 
Maintenance dialog box displays. 

 

5. Select the faulty database and click Repair. The 
system attempts to repair the database. 

 
If the repair is successful, a message displays 
telling you so. Go to step 4. 

 

If the repair is not successful, a message displays 
telling you so. Exit SEDAR and scan your hard 
drive to eliminate other types of computer 
problems. For help, contact the CSAService Desk 
at 1-800-219-5381. When other types of computer 
problems have been eliminated, repeat step 2. 

 

6. Click OK on the message window and on the 
Database Maintenance dialog box to return to the 
SEDAR main window. 

 

7. Reopen the module and resume working. 
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The file extension is not one of the supported file 

extensions. Please select another file or rename the file. 

 

You must follow the naming convention and limit the 
entire path and file name to 60 characters. This means 
that you must limit the file name to eight characters 
and the extension to three characters, as indicated in 
the SEDAR Filer Manual. 

 

1. Click OK to close the dialog box. 
 

2. Select another file or save the file. 
 

3. Click OK to continue with the usual procedure. 
 
 

The file has already been assigned to a document in the 

list. Please select a different file. 

 

There have been some problems with file retrieval 
when the same file names were used for files in 
different directories. Therefore, you cannot send two 
files with the same name within the same filing. 

 

This situation can arise when you are attaching files 
on a cover page. You need to select a unique file 
name. 

 

1. Click OK to close the dialog box. 
 

2. Exit SEDAR, go to the folder where the file is 
located and rename the file. 

 

3. When the file has been renamed, access SEDAR 
and follow the usual procedure for attaching files. 
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An error occurred while sending a submission for 

 

 

project <number>… 
 

If any problems occur while transmitting a submission 
to the SEDAR server, the above message displays. 

 

1. Click OK to close the dialog box. The Filing 
Management window redisplays. 

 

2. Click Refresh List to refresh your local database. 
 

If the submission was successful, two submissions 
with the same project type, filer name, date and 
time of submission appear in the list (not 
necessarily following one another). Go to step 3. 

 

If the submission was not successful, only the 
submission with the label “Inconsistent” displays in 
the list. Recreate the filing and resubmit it. Go to 
step 3. 

 

3. Remove the filing labelled “Inconsistent” from the 
Filing Management list. 

 

4. Continue with the usual procedure. 
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Warning – A file by the name specified already exists on 

 

 

your PC and will be replaced by the file being 
downloaded. Do you want this file replaced? 

C:\SEDAR\directory\file name 

 

There have been some problems with file retrieval 
when the same file names were used for files in 
different directories. Therefore, you can no longer 
send two files with the same name within the same 
filing. However, some filings already submitted may 
contain files with the same file names. 

 

If a file has the same name as a previously retrieved 
file, SEDAR gives you the option to move the file to 
another directory or to rename the file to be retrieved. 

 

This situation can arise when you are retrieving files 
that were previously submitted. You need to select a 
unique file name. 

 

1. When you see this error message, click either: 
 

• Yes—To overwrite the file already in your 
directory. 

• No—To go back to the Receive Document File 
Destination window and select another file 
name or directory. 

 

2. Continue with the usual procedure. 
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The stock symbol is identical to that of another profile 

 

 

in SEDAR. You cannot create this profile. 
Review existing profile. 

 

You cannot duplicate Other Issuer profiles if the stock 
symbol is the same. You must do one of the following: 

 

• Update the existing profile 

• Change the profile you are creating. 
 
 

The issuer has ceased reporting. The profile cannot be 

used to create a filing unless the profile is updated. 

 

This message displays upon submission of a filing 
using the Other Issuer or Investment Fund Issuer 
cover page and the profile of an issuer who  has 
selected “Ceased Reporting” on the Jurisdiction 
where Reporting Issuer field. 
 

 

The submission is saved as a temporary filing and 
displays on the Filing Management main window with 
the status “In Process.” Do the following: 

 

1. Update your profile database. 
 

2. Open the filing, select another profile and submit 
the filing. 
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A virus has been found. 

 

 

 

A scan of files being submitted has identified a virus. 
Please contact the CSA Service Desk at 1-800-219- 
5381 for assistance. 
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files 271 
mail 257 

G–H 
General cover pages 

about 69 
creating 88, 92 

General functions 16 
General Investment Funds cover 

pages 
about 69 
creating 77, 82 

Getting 
help 278, 279 
system information 280, 281 

GST 181, 229 
Hardware information 280, 281 
Help Desk 9 
HST 21, 105, 181, 229 

 

I–L 
Indexed fields 50, 207, 208, 236, 

237 
Informal correspondence See Mail 
Information, about hardware and 

software 280, 281 
Initiating, code updates 275, 277 
Inquiries 

advanced inquiries 201, 209 
building 53, 57, 241, 244 
changing 243, 249 
deleting 243, 249 
modifying 62 
optimizing 
239, 240 
quick search inquiries 184, 200 
saving 244 
submitting 57, 61, 245, 248 

Investment Fund Group profiles 
about 26 
creating 32, 36 

Investment Fund Issuer profiles 
about 30, 37 
creating 37, 41 
updating 65 
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Investment Funds cover pages 
about 69 
creating 71, 76 

Issuer cover pages 
about 69 
creating 83, 87 

Language, setting default 20 
Leased-line connection 

accessing and exiting 
SEDAR 12, 14 

changing passwords 272, 274 
Linking address books 265, 266 
Logon information, setting 

default 20 
 

M–N 
Mail 

See also Address books 
about 250 
creating 251, 255 
deleting 257 
filing 257 
finding addresses 263, 264 
forwarding 257 
opening 256, 258 
receiving files 270, 271 
replying to 257 
reviewing 256, 258 
saving as a file 257 
sending 251, 255 
sending files 267, 269 

Mail lists See Address books 
Modules 

Customer Assistance 17 
Filing Management 17, 98 
Mail 17 
Profile Management 17, 28 
Search Filings 17 
Search Profiles 17 
System Information 17 
User Profile and Defaults 17 

Monitoring 
profiles 63 

Non-indexed fields 50, 237 
Notes   See Mail 

 

O 
Obtaining 

customer assistance 278, 279 
system information 280, 281 

Opening mail 256, 258 
Operators 

about 233 
AND condition 232 
deleting selected operators 242 
modifying 206, 243 
OR condition 231 
recommended 51, 208, 238 
searching 51, 52 
stock symbol 53 
using in fields 233, 235 
wildcard characters 230 

OR condition 231 
Other Filer profiles 

about 26 
creating 48, 49 

Other Issuer profiles 
about 26 
creating 42, 47 
updating 65 

 

P 
Passwords, changing 272, 274 
Preferences, setting up 19, 21 
Private filings 26, 219, 221 
Private profile status 27 
Private profiles  27 
Private vs public 118 
Problems 

common 283, 288 
error messages 289, 295 
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solving 283, 288 
Profile numbers 26 
Profile status 66 
Profiles 

about 25 
creating 

all types 28, 31 
Investment Fund Group 36 
Investment Fund Issuer 37, 41 
Investmentl Fund Group 32 
Other Filer 48, 49 
Other Issuer 42, 47 

database 68 
monitoring  63 
private vs public 27 
removing 35 
retrieving filings by, details 193, 

196 
searching 

about 50, 52 
building inquiries 53, 57 
modifying inquiries 62 
recommended operators and 

criteria 51 
submitting inquiries 57, 61 

types of 26 
updating 64 
viewing status 66 

Project numbers 
about 68 
retrieving filings by 192 

Projects 
about 67 
accessing as secondary 

filers 147, 150 
adding documents 152, 157 
adding fees 151, 178, 182 
adding formal 

correspondence 166, 169 
adding previously filed 

documents 158, 165 
adding secondary filers to 137, 

139 
deleting secondary filers 

from 139, 141 
downloading 147, 148 
refreshing 216 
retrieving filings by project 

number 192 
submitting 121, 127 
updating secondary filer 

information 143, 146 
viewing filing status 222, 223 

Prospectus, submitting 68 
Public filings 26, 219, 221 
Public profile status 27 
Public profiles  27 

 

Q–R 
QST 21, 181, 229 
Quick search inquiries 

about 184 
creating 186 
deleting 186 
dialog box 185 
modifying 186 
refreshing the filing list 187 
renaming  186 
retrieving filings 

by date 191 
by profile details 193, 196 
by project number 192 

using 184, 200 
wizard 187 

Receiving files 250, 270, 271 
Recipient agencies 

adding after submission 174, 177 
changing access levels of 

documents 221 
deleting 176 
selecting 99, 102 

Refreshing 
files 271 
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filing list 216, 217 
filing list, quick search 

inquiries 187 
project 216 
user information 21 

Removing 
filer profiles 35 

Renaming quick search 
inquiries 186 

Replying to mail 257 
Retrieving 

files 270, 271 
filings 245, 248 

advanced inquiries 201, 209 
quick search inquiries 187, 200 

formal correspondence 224, 226 
Reusing documents 119 
Reviewing mail 256, 258 

 

S 
Saving 

advanced inquiries 206 
inquiries 244 
search inquiries 57 

Search criteria 
about 233 modifying 206, 
243 recommended 51, 
208, 238 using 233 

Searching 
See also Advanced inquiries 
See also Quick search inquiries 
fields, operators and criteria 

about 233 
adding and deleting 242 
AND condition 232 
indexed fields 236, 237 
non-indexed fields 237 
OR condition 231 
recommended 238 
stock symbol 240 

wildcard characters 230 
for addresses 263, 264 
tips 236, 240 

Searching for filings 
about 230 
building inquiries 241, 244 
deleting inquiries 243 
modifying search inquiries 249 
optimizing inquiries  239, 240 
saving inquiries 244 
submitting search inquiries 245, 

248 
Searching for profiles 

about 50, 52 
building inquiries 53, 57 
modifying inquiries 62 
operators 52 
recommended operators and 

criteria 51 
submitting inquiries 57, 61 

Secondary filers 
about 128, 136 
access 136 
accessing projects 147, 150 
adding to projects 137, 139 
changing access 142, 143 
deleting from projects 139, 141 
downloading projects 147, 148 
updating information in a 

project 143, 146 
verifying access 149, 150 

SEDAR 
about 10 
accessing 12 
contacting Help Desk 278, 279 
exiting 12, 14 
modules 17 
server 119 
setting up 19, 21 
updating codes 275, 277 
using 16, 17 
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Selecting 
recipient agencies 99, 102 

Sending 
files 250, 267, 269 
mail 251, 255 
projects 121, 127 
prospectus 68 
search inquiries 57, 61, 245, 248 
submissions 70 
user information 24 

Setting up 
date format 19 
default directory 20 
language 20 
logon information 20 
user defaults and 

preferences 19, 21 
Software information 280, 281 
Sorting entries in submission 

lists 214, 215 
Stock symbols 

searching 53 
searching by 240 

Submission numbers 68 
Submissions 

about 67 
access 150 
adding documents 151 
adding fees 178, 182 
adding recipient agencies 174, 

177 
customizing view 214, 215 
sending 70 
transmitting 121, 127 
viewing completed 127 

Submitting 
filings 98 
profile search inquiries 57, 61 
projects 121, 127 

System information 280, 281 

T 
Taxes 181, 229 
Technical support 278, 279 
Third Party cover pages 

about 70 
creating 93, 97 

Tips 
for customizing advanced search 

inquiries 207, 209 
searching effectively 236, 240 
troubleshooting 282 

Troubleshooting tips 282 
 

U 
Updating 

advanced inquiries 206 
cover pages 170, 173 
fields, operators and criteria 243 
filer information 132, 133 
profile search inquiries 62 
profiles 64 
quick search inquiries 186 
search inquiries 243, 249 
secondary filer information in a 

project 143, 146 
SEDAR codes 275, 277 

User authorization 
changing 23, 24 
verifying 23, 24 

User information 
entering 21 
submitting 24 

Using 
address books 259, 266 
advanced inquiries 201, 206 
indexed and non-indexed 

fields 50 
indexed fields 236, 237 
quick search inquiries 184, 200 
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V–Z 
Verifying 

access authorization 23, 24 
access levels of documents 219, 

221 
banking authorization 23, 24 
fee payments 227, 229 
filing lists 211, 215 
filing status 121, 127, 222, 223 
profile status 66 
secondary filer access 149, 150 

Wildcard character 230 
Wizard, quick search inquiry 187 


